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Getting Started 
If you are building your own FAXCOM Server, start with Chapter One, skip Chapter 
Two, and continue with Chapter Three. 

If you have received a pre-built system from Biscom, skip Chapter One, start with 
Chapter Two, and continue with Chapter Three. 

Once you have completed the steps in Chapter Three, you have done what is 
necessary to implement a fully functioning system that sends and receives faxes.  
The remaining chapters provide a reference to the full capabilities of the system, 
which you can then implement as appropriate to the needs of your site. 

This guide has the following organization: 

Chapter One – Build the FAXCOM Server – explains how to create a FAXCOM Server 
yourself (by building the server platform, installing the appropriate Dialogic 
Brooktrout board(s) and installing the FAXCOM Server software from CD). 

Chapter Two – Get Started with a Pre-built FAXCOM Server – describes how to login 
to a system pre-built at Biscom and specify its IP address. 

Chapter Three – Perform the Basic Configuration and Send a Test Fax – explains 
how to quickly get the system up-and-running, by configuring the connection of 
the fax ports to your telephone network, sending a test fax to verify successful 
connection, and understanding the routing of incoming faxes to your front-end 
FAXCOM fax service (either FAXCOM Suite for Windows or FAXCOM for Domino). 

Chapter Four – Configure Full Capabilities of the FAXCOM Server – gives an 
overview of all capabilities of the system, and how you can configure these 
capabilities within the FAXCOM Server Administrator program.   

Chapter Five – Manage and Monitor the FAXCOM Server – provides an overview of 
the basic tasks you perform with the FAXCOM Server Administrator program in order 
to monitor the operations of the FAXCOM Server 

Chapter Six – Install and Use Qdoctor – explains the procedures for installing and 
using Qdoctor, the utility that enables access to a log of faxes “quarantined” on the 
FAXCOM Server as possible Spam faxes. 

Appendix A – Status Codes and Explanations – lists and explains the status 
messages (i.e., successful completion message and error messages) returned by the 
FAXCOM Server. 

Appendix B – Configure Advanced Settings – describes some advanced features you 
can implement by working directly within the configuration files.  There are three 
advanced configuration files – one for fax ports, one for host ports/sessions, and 
one for server settings.   
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Appendix C – Use the FAXCOM Control Utility – describes how to use the FAXCOM 
Control utility, a command line utility with which you can control certain functions 
of the FAXCOM Server. 

Appendix D – Dialogic Brooktrout Fax Board Fax Driver Parameters – explains 
several Brooktrout fax board device driver parameters you may have to change to 
implement certain capabilities you require. 

Appendix E – Supported Dialogic Brooktrout Fax Boards – lists the supported 
Brooktrout fax boards. 

Appendix F – Install Translation Server Applications – gives instructions for 
installing Adobe Acrobat and the MS Office suite according to the needs of the 
Translation Server component 

Appendix G – Implement the Dialogic Brooktrout SR140 Virtual Fax Board – lists 
the steps for implementing this software-only host-based fax-over-IP platform
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Chapter One:  Build the FAXCOM Server 

Step 1:  Build the Server Platform 
You build the server platform by doing the following: 

- Confirm the system meets these basic requirements: 

o Pentium® 4 system 

o 2 GB RAM 

o 36 Gigabyte available space 

Note:  If your FAXCOM Server has more than 48 ports and is also running the 
Translation Server function, Biscom recommends going beyond these basic 
requirements and using a Xeon processor-based system with additional RAM. 

o Either Windows 2008 R2 or 2003 SP2 – with NTFS file system 

Note:  Refer to the “Configure the Firewall to Open Ports on the FAXCOM Server” 
section immediately below to determine if the Operating System (OS) 
configuration you are running requires you to configure the Firewall to open ports 
on the FAXCOM Server. 

- Internet Explorer 6.0 or higher 

- Supported fax board, as listed in Appendix E 

 Note:  You may also be using a FAXCOM Server with the Dialogic Brooktrout 
SR140 virtual fax board.  In that case, refer to Appendix G for implementing this 
software-only  solution on a FAXCOM Server. 

- Confirm SNMP is installed (for use in generating alarms based on server status) 

- If you are running the Translation Server function, install the Windows 
applications you want automatically to translate.  The supported applications 
are:  MS Word, MS Excel, MS PowerPoint, MS Project, MS Access Snapshot files, 
MS Publisher, the Lotus suite, WordPerfect, Visio, Adobe Acrobat, and HTML 
documents. 
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Notes:  The Translation Server function also translates Web Page HTML 
documents, using the Internet Explorer application already installed. 
Refer to Appendix F for instructions on installing Adobe Acrobat and MS Office 
according to the requirements of the Translation Server. 
Refer to the “Step 9: Install a Microsoft Hot Fix or Upgrade to a Higher Service 
Pack” section later in this chapter for more information on why Biscom requires 
specific OS versions on a FAXCOM Server performing MS Word document 
translations. 

Configure the Firewall to Open Ports on the FAXCOM Server 
If you have enabled Firewall on your FAXCOM Server, you must do the following to 
configure the Firewall to open ports on the FAXCOM Server. 

In the vast majority of cases, the only TCP Port on the FAXCOM Server you need to 
open is 6001, used to communicate with the FAXCOM Queue(s).  The following 
table, however, lists all ports likely to be used. 

TCP PORT INFORMATION USED BY THE FAXCOM SERVER 

Host Port Name Default TCP Port Number 

TRAN Port (used to communicate with FAXCOM Queues) 6001 

SMTP Host Port 25 

TCP Host Port 6000, 6002-6005 

Do the following to configure the Firewall: 

1. Click Start…Run. 
- In the Open box, type netsh to display a command prompt window. 
- Type firewall.  
- Type add portopening TCP <Port number to be allowed through the 

firewall> <name> 
as, for example, add portopening TCP 6001 FaxTran 

- Repeat Step 4 until all needed FAXCOM host ports are opened; type Exit. 

Consideration for Running Antivirus Scan Software on the 
FAXCOM Server 
Assuming that you want to protect your FAXCOM Server from viruses and malicious 
code, be aware of the following important consideration for running antivirus scan 
software: 

Exclude the FAXCOM Server’s u directory (and all subdirectories) when running a 
real-time scan.  It is recommended that you run only a scheduled antivirus scan of 
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the u directory.  If you have installed a front-end Biscom product – such as 
FAXCOM Suite for Windows or FAXCOM for Domino – exclude the bisfax directory 
as well when running a real-time scan.  Run only a scheduled antivirus scan of the 
bisfax directory. 
In addition, if you are using Office 2007 on the FAXCOM Server to translate native 
files, you must exclude the following directory from real-time virus scanning:  
C:\Documents and Settings\Default User\Application 
Data\Microsoft\Office\Recent. 

Step 2:  Install the Appropriate Dialogic Brooktrout Fax 
Board 
Refer to the Dialogic documentation to install the fax boards according to the board 
type and phone line requirements.  DO NOT INSTALL THE FAX BOARD DRIVERS.  If 
you have already installed the fax board drivers, remove them according to the 
instructions from Dialogic. 

Note:  Appendix E lists the supported Dialogic Brooktrout boards. 

If using Direct Inward Dial (DID) lines, connect the DID power supply and cable to 
the DID board. 

Set the Module Number of the TR1034 Board 
Set each board to a unique module number to easily identify the resources 
associated with a specific board in a multi-board system. 

Use the SW-1 rotary switch (Figure 1-2) to set a unique module number for each 
Dialogic Brooktrout board.  Select a number from 2-F on the rotary switch.   Settings 
0 and 1 are reserved and cannot be used.  

 

Figure 1-1.  SW-1 Rotary Switch 

In a multi-board installation, for example, set the boards as follows: 

Board Module Number 
First installed board 2 

Second installed board 3 
Third installed board 4 
Fourth installed board 5 
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Step 3:  Physically Connect to the Telephone Network 
Connecting the FAXCOM Server to the telephone network varies in complexity 
according to which of the following supported interfaces are used: 

- Loop-start or DID individual analog lines 

- TI- 24-channel E&M digital lines 

- PRI – 23-channel Primary Rate ISDN digital lines 

- E1 – 30-channel Euro ISDN digital lines 

Notes:  If necessary, refer to Appendix E for for a list of the supported fax boards 
and the telephone interfaces they support. 

Step 4:  Power On the System, Login, and Cancel the 
Hardware Wizard 

When you power on your system and login, the Found New Hardware Wizard may 
automatically be displayed to help you install fax board driver software for the PCI 
fax board you just installed.  Since the fax board driver software will be installed for 
you when you continue and install the FAXCOM software, you do not want the 
Wizard to help you install drivers.  Do the following, therefore, to exit the Wizard: 

• When the  Welcome to the Found New Hardware Wizard screen (Figure 1-2) is 
displayed, click Cancel to exit the wizard. 

 

Figure 1-2.  Found New Hardware Wizard 
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Step 5:  Have Available the Following Information 
Before running the installation, you should have available the following general 
information: 

• Whether you are using a physical fax board or the SR 140 virtual fax board 

• Whether the physical fax board is a TR1034 or a TRUFAX board 

• Whether the TR1034 board is Digital, Analog/DID, or BRI 

• Whether the TRUFAX board is BRI  

• If using digital lines (i.e., T1/E1/PRI/T38), the number of digital lines 

Note:  Biscom – as does Dialogic – strongly recommends use of a Channel Service 
Unit (CSU) for T-1 installations connecting directly (not through a PBX) to the 
phone company.  For a fuller explanation of the functions provided by a CSU, refer 
to the Dialogic Knowledgebase Article #1146.     

The following sections detail the specific information – according to telephone line 
type – for which you will be prompted: 

T1 Parameters 
• Number of boards 

• Size of boards (i.e., number of ports) 

• Whether the T1 signaling protocol is the default of robbed-bit E and M Wink or 
robbed-bit E and M Immediate 

• Whether the framing is the default of Extended Superframe (ESF) or Superframe 
(SF) 

• Whether the line coding is the default of  B8ZS or AMI 

PRI Parameters 
• Number of boards 

• Size of boards (i.e., number of ports) 

• Whether the switch type is the default of AT&T #4 ESS or one of the following:  
AT&T #5 ESS, Nortel DMS 250, Nortel DMS 100 

E1 Parameters 
• Number of boards 

• Size of boards (i.e., number of ports) 

• Whether the ISDN variant is the default of Euro ISDN or Q.931 
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T.38 Parameters 

Note:  Be aware that Dialogic requires that any Cisco router you are deploying be 
running Cisco IOS version 12.3 (7) or higher of the Cisco Internet Operating 
System (IOS). 

• Number of boards (=1) 

• Size of boards (i.e., number of ports) 

• T.38 SIP Gateway IP address (of the Cisco router) 

• TR1034 board IP address 

• TR1034 board subnet mask 

Note:  Be aware that the TR1034 board IP address and subnet mask are in addition 
to the IP address and subnet mask of the FAXCOM Server Network Interface Card 
(NIC) itself. 

Step 6:  Install the FAXCOM Server Software 
Do the following to install the FAXCOM Mailbox Server: 

If Installing from a CD: 

1. Insert the FAXCOM Server CD into a CD-ROM drive.  The installation 
program should automatically start for you.  If it does not, run Setup.exe. 

Or 

If Installing from a Biscom Delivery Server (BDS) Package Download: 

2. On the machine where you will install FAXCOM Server, use an unzip utility 
to unzip the FAXCOM Server 6.x.x.xx zip file and extract the archived files.  
Run Setup.exe. 

Note:  If you receive a Windows Installer message stating “Error opening 
installation log file.  Verify that the specified log file location exists and is 
writable,” right-click the setup.exe file and select “Run as Administrator.” 

3. Accept the license agreement and click Next to display the Customer 
Information screen (Figure 1-3). 
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Figure 1-3.  Customer Information Screen 

4. Supply the information provided to you by Biscom (on the Base License 
Information sheet), and click Next to display the Custom Setup screen (Figure 1-
4). 
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Figure 1-4.  Custom Setup Screen 

5. Either accept the default destination location or click the Change button, specify 
an alternate drive location, and click OK.  Click Next to display the Fax Board 
Hardware Type screen (Figure 1-5). 
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Figure 1-5.  Fax Board Hardware Type Screen 

6. Make the appropriate selection and click Next.  With some selections, the Ready 
to Install screen (Figure 1-6) is displayed. 

For other selections, a subsequent screen may be displayed, prompting you for 
more information – as listed in the “Step 5:  Have Available the Following 
Information” section immediately above.  Supply the appropriate information and 
click Next to display the Ready to Install screen (Figure 1-6).   
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Figure 1-6.  Ready to Install Screen 

7. Click Begin to copy the files, and then display the Welcome to the FAXCOM 
Server Configuration Wizard screen (Figure 1-8). 

If a prompt is displayed (as shown in Figure 1-7), asking you whether to increase 
the number of ports according to your license, click Yes to continue and display 
the Welcome to the FAXCOM Server Configuration Wizard screen (Figure 1-10). 

  

Figure 1-7.  Configuration Wizard Prompt 
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Note:  If it appears that the installation is not completing and displaying the 
Configuration Wizard, it may be that the Configuration Wizard window is hidden 
behind other windows.  In that case, simply click the Configuration Wizard icon 
(which is next to the Installation program icon) in the Status bar 

 to display the wizard and complete the installation. 

 

 

Figure 1-8.   Welcome to the FAXCOM Server Configuration Wizard Screen 

Step 7:  Run the Configuration Wizard to Accept the 
Defaults 
Do the following to run the Configuration Wizard, accept the configuration defaults 
and then exit the Configuration Wizard.  (Once the installation completes and you 
have successfully set up FAXCOM Server, you can always run the FAXCOM Server 
Administrator program to change any configuration settings.) 
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1. On the Welcome to the FAXCOM Server Configuration Wizard screen (Figure 1-
8), click Next to display the Configure FAXCOM Server dialog (Figure 1-9). 

 

Figure 1-9.  Configuration Wizard Configure FAXCOM Server Dialog 

2. Click Finish to exit the wizard and complete the installation. 

Step 8:  Apply any Available Hotfixes  
If your product CD includes a HOTFIX folder, do the following to upgrade your 
FAXCOM server software with the latest improvements. 

1. Copy the HOTFIX folder to the hard drive where you installed the FAXCOM 
software. 

2. Make sure the FAXCOM Server Administrator program is closed. 

3. Open the HOTFIX folder on the hard drive. 

4. Double-click the hotfix.cmd icon.  A command window opens, and as the 
HOTFIX installation runs, the screen is updated as to the operation taking place 
and at certain intervals you are prompted to “Press any key to continue.” 
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5. When so prompted, press any key to continue until the HOTFIX installation is 
complete and you are returned to the folder listing. 

6. Remove the CD.   The FAXCOM service is automatically started for you.   

Step 9:  Install a Microsoft Hot Fix or Upgrade to a Higher 
Service Pack 
An instability in MS Windows 2000 SP4, XP, and 2003 occurs after the translation of 
thousands of Word documents. 
To deal with the instability problem in MS Windows 2000 SP4, Microsoft has 
published Knowledge Base article, 826518.  To access the article and obtain the hot 
fix, go to http://support.Microsoft.com/?id=826518 and follow the instructions for 
contacting Microsoft to obtain the hot fix. 
To deal with the instability problem in Microsoft XP, you must install SP2. 
To deal with the instability problem in Microsoft Windows 2003, you must install 
SP1. 

Step 10:  Create a New User Account with which the 
FAXCOM Server Service Will Run 
If you will be using the Translation Server function to translate native file fax 
attachments, use the information in this section to create a new user account with 
which the FAXCOM Server service will run (in the event you choose not to use an 
existing user account for the purpose.) 

Note:  Be aware that the user account you create must be a Local Admin and have 
rights to any network resources to which faxes will be routed, such as printers or 
UNC paths not on the local system. 

1. Select Start…Settings…Control Panel…Administrative Tools…Computer 
Management.  Expand Local Users and Groups and select Users (as shown in 
Figure 1-10). 
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Figure 1-10.  Computer Management Local Users and Groups…Users 

2. Right-click Users and select New User… to display the New User dialog (Figure 
1-11). 
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Figure 1-11.  New User Dialog 

3. As shown in the example in Figure 1-13, specify a User name and Description; 
make sure to select (check) the User cannot change password and Password 
never expires checkboxes; click Create; click Close. 

4. When returned to Computer Management, select the newly-created user and 
select Properties from the shortcut menu.  Select the Member of tab and click 
the Add… button to display the Select Groups dialog.  Type in Administrators 
and click OK. 

5. When returned to Computer Management, select Services and 
Applications…Services.  Double-click the FAXCOM Server service to display its 
Properties. 

6. Select the Log On tab (Figure 1-12). 
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Figure 1-12.  Log On Tab 

7. In the Log on as section, select the This account radio button.  Click the 
Browse… button to select the user account you created for the FAXCOM Service 
(in step 3 above).  Enter the Password in the Password field, confirm the 
Password and click OK.  You have now configured the FAXCOM Server service to 
run as the user account you created.    

Step 11:  Continue with the Steps in Chapter Three 
Once you have completed steps 1 through 10, you are ready to continue with 
Chapter 3 and do the only configuration necessary to be up-and-running.  Skip 
Chapter Two, as it pertains only to FAXCOM Servers pre-built at Biscom.
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Chapter Two:  Get Started with a Pre-built FAXCOM Server 
When your FAXCOM Server is built, configured and tested at Biscom, you only have 
to perform the following preliminary steps before doing the minimal configuration 
required to be up-and-running: 

• Physically connect to the telephone network 

• Login to the server 

• Change the IP address 

• Change the Biscom-established user account configuration 

Note:  The information included in Chapter One does NOT apply to FAXCOM 
Servers pre-built at Biscom, and you can skip that chapter. 

Physically Connect to the Telephone Network 
Connecting the FAXCOM Server to the telephone network varies in complexity 
according to which of the following supported interfaces are used: 

- Loop-start or DID individual analog lines 

- TI- 24-channel E&M digital lines 

- PRI – 23-channel Primary Rate ISDN digital lines 

- E1 – 30-channel Euro ISDN digital lines 

Note:  If necessary, refer to Appendix E for for a list of the supported fax boards 
and the telephone interfaces they support. 

Change the Biscom-Established User Account 
Configuration 
With Office 2003, SP2, the FAXCOM Server service must run as a user, and beginning 
January 2006, all turnkey FAXCOM Servers created at Biscom will be configured 
accordingly. 

Use the information in this section in order to change the Biscom-established user 
account configuration to a user account configuration unique to your site. 

Biscom-Established Information: 

The FAXCOM Server service has been configured at Biscom to run as a user called 
FAXCOMService, with a password set to hello5.  As appropriate, either change the 
password for the FAXCOMService user account, or delete the FAXCOMService user 
account entirely, in order to run as a user account of your own choosing. 



18 

Note:  Be aware that when you change the password, you must change it both for 
the user account with which the service runs and for the FAXCOM Server service 
itself.  In addition, the user account you choose must be a Local Admin and have 
rights to any network resources to which faxes will be routed, such as printers or 
UNC paths not on the local system. 

Login to the FAXCOM Server  
Biscom ships a pre-built FAXCOM Server with a login account, as follows: 

User Name: administrator 

Password: hello5 

You can select Start…Control Panel…Administrative Tools  to specify different 
values for the Login Account and Password – so long as the Login Account has 
Administrator rights to the local machine. 

Note:  Be aware that systems running on Windows 2008 (only) require a longer 
password, which is BiscomHello5.  

To login to the server, do the following: 

1. After powering up the server, when prompted, press Ctrl-Alt-Del. 

2. Enter the login name and corresponding password to display the desktop. 

Change the IP Address 
If you received a FAXCOM Server built at Biscom, Biscom sets an IP address of 
128.1.1.2 for testing purposes, which you must change for your particular site.  You 
change the IP address as follows: 

Windows 2000/2003: 

1. Select Start…Settings…Control Panel…Network and Dial-up Connections…Local 
Area Connection…Properties…Internet Protocol (TCP/IP)…Properties. 

2. Enter the appropriate information and click OK. 

Windows 2008: 

1. Select Start…Network…Network Sharing Center…Change Adapter Setting…Local 
Area Connection…Properties…Internet Protocol Version 4…Properties. 

2. Enter the appropriate information and click OK. 
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Understand the Default Configuration 
When FAXCOM Server is shipped to you with the software pre-installed, a basic fax 
port/host port default configuration is established.  You need only change the pre-
configured IP address (as described immediately above) for your specific location to 
be up and running with the default configuration. 

Fax Port Default Configuration 
Direct Inward Dial (DID) Lines 

Fax ports connected to DID lines are set to Receive Only (and must be set to Receive 
Only); all other fax ports are set to Transmit Only. 

Non-DID Loop Start Lines 

Fax ports are set to Transmit/Receive (unless otherwise requested). 

Host Port Default Configuration  
While all FAXCOM Server models support 6 host ports, only 2 are configured for you, 
with only host1 enabled, meaning all incoming faxes can be automatically routed to 
host1.  Host ports are set to the TRAN connection mode, with 6001 as the TCP Port 
Number – with the following exception:  when used with the FAXCOM for NDS 
product, Host ports are set to the TRAN connection mode, with BIS_RXSESS specified 
as the Session Name and entered into the Inbound Routing tab (Figure 4-14). 

Continue with the Steps in Chapter Three 
You are now ready to peform the only configuration necessary to be up-and-
running – as described in Chapter Three. 
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Chapter Three:  Perform the Basic Configuration and Send 
a Test Fax 
Note:  Release 9.6 of the FAXCOM Suite for Windows MMC includes a snap in with 
which to remotely manage the FAXCOM Servers connected to the Suite 
environment.  Release 5.5.13.70 or higher of the FAXCOM Server is required in 
order to use the FAXCOM Suite for Windows MMC for remote server management. 
Releases 5.5.13.70 and higher include the FAXCOM Data Manager service, which 
runs on each FAXCOM Server to support remote MMC management.  

Although there are many capabilities of the FAXCOM Server that you can implement 
through configuration settings specified/selected via the FAXCOM Server 
Administrator program (and described in Chapter Four), you have to do only the 
following to quickly be up-and-running: 

• Configure the fax ports 

• Specify the number of digits to be detected for inbound routing 

• Send a test fax to confirm successful installation 

• Understand inbound routing to your front-end fax service 

• If  using the TR1034 fax board and unable to successfully send a test fax, 
review the TR1034 configuration settings (as described later in this chapter), 
and, if necessary, reconfigure the TR1034 board 

• If using the SR140 virtual fax board and unable to successfully send a test fax, 
review the SR140 configuration settings (as described later in this chapter), and, 
if necessary, reconfigure the SR140 settings  

Run the FAXCOM Server Administrator Program 
To run the FAXCOM Server Administrator program, do the following: 

• Select Start…Programs…FAXCOM…FAXCOM Server Administrator. 
When the FAXCOM Server Administrator program opens, a set of three windows 
is displayed on the FAXCOM desktop – the Job Statistics, Tasks, and Fax Ports 
windows.  

You can resize the windows, maximize them, close them or re-open them by 
clicking the Window menu and selecting the window you want to view. 
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Configure the Fax Ports 
This section does not explain each of the fields you can configure on the Fax Ports 
tab, but only those fields you need to be concerned with to quickly get up-and-
running.  An explanation of all fields is included in Chapter Four. 

Do the following to configure fax ports, the connections to the telephone lines: 

1. Click the Configure toolbar button  and select the Fax Ports tab (Figure 3-
1).  (You can also select Configure…Ports…Fax Ports or Configure…All 
Settings…Fax Ports.) 

 

Figure 3-1.  Configure Fax Ports Tab 

2. To configure the port, highlight the port and click the Configure button to 
display the Fax Port dialog (Figure 3-2).  (If the port is not stopped, you are 
prompted whether to stop the port since you cannot configure a port unless you 
first stop it.  You can, however, view the configuration in read-only mode 
without stopping the port.) 
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Figure 3-2.  Fax Port Dialog  

3. Specify the appropriate information as follows, clicking OK when done: 

Port Mode – either Transmit/Receive if both outbound and inbound fax traffic 
are to be handled over this port; Transmit Only if only outbound traffic is 
allowed, with no incoming calls answered; Receive Only if only inbound fax 
traffic is to be handled over this port, with no outbound fax jobs queued to the 
port. 

Note:  You MUST specify Receive Only when connecting the fax port to a DID 
trunk. 

Auto Route Method – set to None if no auto routing is configured; DTMF for 
DTMF routing; DID for DID routing.  Refer to the “Configuring Inbound Routing” 
section later in this chapter for more information on routing incoming faxes. 

Specify the Number of Digits to be Detected for Inbound 
Routing (if DID or TI/PRI/E1) 
Do the following to specify the number of digits to be detected for inbound routing 
of received faxes.  (If your FAXCOM Server was pre-built at Biscom, it is shipped with 
a default value of 4, which you may have to change.) 

1. Click the Configure toolbar button  and select the Server Settings tab 
(Figure 3-3).  (You can also select Configure…Server Settings or Configure…All 
Settings…Server Settings.) 
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Figure 3-3.  Server Settings Tab 

2. In the Inbound Routes Number of Digits box, specify the appropriate number of 
digits.  Click Done. 

Send a Test Fax 
Do the following to send a test fax in order to confirm successful installation of the 
FAXCOM Server: 

1. From the Action menu, select Send a Test Fax.  The FAXCOM Server Test dialog 
box (Figure 3-4) is displayed, with the name or internal IP Address of the 
FAXCOM Server itself and the default TCP port number prefilled. 
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Figure 3-4.  FAXCOM Server Test Dialog 

2. In the Telephone Number box, specify the fax number of a nearby fax machine. 

3. Either specify fax message text in the Message box, or click the Load from File 
button to select a file to comprise the fax message text.  Note that you can click 
the Clear button to delete the default message text. 

4. If appropriate, click the Add Attachment button and select a file attachment.  
Note that you can click the Clear button to remove a previously-added 
attachment. 

5. Click the Send Fax button.  After a pause, the Completion Status window is 
displayed. 

6. Confirm the result is trok (for transmit ok). 

7. When returned to the FAXCOM Server Test dialog, close the dialog. 
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Note:  If your test fax was not successfully sent – and your telephone line type is 
T1/PRI/E1 – you may need to modify configuration information for the TR1034 fax 
board, as described in the “Configure TR1034 Setup” section later in this chapter. 

Understand Inbound Routing (if DID or TI/PRI/E1) 
If you are connecting to the FAXCOM Server with one FAXCOM Queue (i.e., front-end 
fax service gateway) only, you do not need to configure any inbound route entries.  
Routing is done to the Default Route, which is created automatically by the first 
FAXCOM Queue that attempts to pick up faxes from the fax server – and you can 
just accept this default route. 

At this point, you have done what is necessary to implement a fully functioning 
system that sends and receives faxes. 

If, however, you have multiple servers/FAXCOM Queues, you need to create 
additional inbound route entries to route to the additional FAXCOM Queues (as 
described in the “Configure Inbound Routing” section in Chapter Four).  You would 
create these entries after installing your front-end fax service and creating the 
FAXCOM Queues. 

Configure TR1034 Settings 
Note:  Biscom – as does Dialogic – strongly recommends use of a Channel Service 
Unit (CSU) for T-1 installations connecting directly (not through a PBX) to the 
phone company.  For a fuller explanation of the functions provided by a CSU, refer 
to the Dialogic Knowledgebase Article #1146. 

During the installation of the FAXCOM Server software, you were asked to specify 
information for your telephone line type (TI/PRI/E1) in order to work correctly with 
the TR1034 T1/PRI/E1 fax board.  In the event you need to change the information 
you specified during the installation, do the following – being aware that the 
TR1034 tab is not visible if you do not have a TR1034 T1/PRI/E1 fax board: 

1. Click the Configure toolbar button  and select the TR1034 Settings tab 
(Figure 3-5).  You can also select Configure …All Settings… TR1034 Settings.  
Note that the fields on the tab change depending on your selection of Telephone 
Line Type. 
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Figure 3-5.  TR1034 Setup Tab (T1) 

2. Change settings where appropriate, keeping the following in mind: 

Debug logging – select this option only if so advised by Biscom Support 
personnel. 

V.34 Mode – select this option in order to transmit faxes at a transmission speed 
faster than 14.4 kb/s and up to 33.6 kb/s.  

Cable length is the one aspect of T1/PRI setup you were not asked to specify 
during the installation of the FAXCOM Server software.  If the length of your 
cable exceeds 132 feet, change the default setting to the setting that most 
closely corresponds to the actual length of your cable.  Set the length as 
accurately as possible since an incorrect setting affects signal quality and proper 
operation of the board. 

You must restart the FAXCOM service for any changes to take effect. 

If you select T1– 24-channel E&M digital lines, make any appropriate changes 
to the following settings:  Number of Telephone Line Interfaces, T1 Protocol, 
Cable Length, T1 Framing, T1 Coding.  Click Done. 

If you select E1 -  30-channel ISDN digital lines, make any appropriate changes 
to the following settings (as shown in Figure 3-6):  Number of Telephone Line 
Interfaces, ISDN Switch, ISDN Variant.  Click Done. 
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Figure 3-6.  TR1034 Setup Tab (E1) 

If you select PRI – 23-channel Primary Rate ISDN digital lines, make any 
appropriate changes to the following settings (as shown in Figure 3-7):  Number 
of Telephone Line Interfaces, Cable Length, ISDN Switch, ISDN Variant.   

Click Done. 
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Figure 3-7.  TR1034 Setup Tab (PRI) 

Configure SR140 Settings 
If you chose SR140 Virtual Fax Board (T38) during the installation of the FAXCOM 
Server software, and implemented this boardless implementation according to the 
instructions in Appendix G make any changes to the following settings: 

1. Click the Configure toolbar button  and select the SR140 Settings tab 
(Figure 3-8).  You can also select Configure…All Settings… SR140 Settings. 
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Figure 3-8.  SR140 Settings Tab 

2. Make the appropriate selections according to your implementation: 

Licensed channels – a read-only field that displays the number of fax ports for 
which you are licensed. 

License Manager – click this button to display the Brooktrout License Manager, 
with which to activate your SR140 license. 

Debug logging – select this option only if so advised by Biscom Support 
personnel. 

V.34 Mode – select this option in order to transmit faxes at a transmission speed 
faster than 14.4 kb/s and up to 33.6 kb/s. 

Mode – select T.38 to use T.38 only; select T.38 + G.711 to try to use T.38, 
falling back to G.711 if unsuccessful; select G.711 to use G.711 fax pass-
through. 

Call Control – select the call control method used for Voice Over IP, either: 

SIP for the Session Initiation Protocol, a text-based protocol, similar to HTTP 
and SMTP, designed to manage multimedia sessions over the Internet; while 
SIP is responsible for determining the peer IP address and port number on 
which to communicate, it does not perform the actual physical transport of 
the media, which is typically done via TCP/IP. 
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H.323 for the standard that describes how multimedia communications 
occur between terminals, network equipment, and services, and which is part 
of a larger group of ITU recommendations for multi-media interoperability 
called H.3x.  H.323 addresses call control and management for both point-
to-point and multipoint conferences as  well as gateway administration of 
media traffic, bandwidth, and user participation. 

Call Control Variant – select either Default, Cisco CallManager, or Avaya, and 
typically Default. 
Round Robin – if you have two or more entries for Gateway IP Address, select 
this option to specify a form of load balancing whereby faxes are cycled to each 
gateway on a rotating basis. 

Be aware that In the event a gateway is unavailable, the application marks that 
gateway as unavailable for 10 minutes before trying again – regardless of whether 
or not the Round Robin option is selected.    

T.38 Version – a field that is activated when V.34 Mode is not checked, and 
which enables you to select the T.38 Version, either 0, 1, 2, or 3.  

Gateway IP Address – specify the IP Address of the Cisco router in use and click 
the Add button to add it to the list.  Use the Move Up and Move Down buttons 
as appropriate to move entries within the list (where the topmost entry is the 
first one that will be used); click the Remove button to delete a selected entry 
from the list. 

Note that you can specify a machine name in the Gateway IP Address and Local IP 
Address fields and the application will convert the name to the corresponding IP 
Address. 

IP Preference – select either IPV4 Only, IPV6 Only, IPV4 Preferred, IPV6 Preferred, 
being aware of the following consideration: 

Unless you have configured the system to use both IPV4 and IPV6, you must 
select IPV4 Only. 

Local IP Address – specify the IP Address of the system, being aware that you 
can enter a machine name that will be converted to an IP Address. 

H.323 Gatekeeper IP Address – if you have selected H.323 for Call Control, 
specify the IP Address of the H.323 Gatekeeper. 
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Chapter Four:  Configure Full Capabilities of the FAXCOM 
Server 
This chapter describes all features of FAXCOM Server that you can implement 
through configuration settings specified/selected via the FAXCOM Server 
Administrator program.  You implement these features by configuring: 

• Fax Ports 

• Host Ports 

• Server Settings 

• TR1034 Settings 

• SR140 Settings 

• Alarm Management Events and Notification Methods 

• Inbound Routing 

• Options and the Number of Fax Ports 

• Dialing Rules and Least Cost Routing 

• Translation Server 

• Data Archive 

• SMTP Integration 

Configure Fax Ports 
When you select a specific port (either host port or fax port) and click the Configure 
button to configure it, you can either make changes to the port configuration or 
view the configuration in read-only mode.  For that reason, you are prompted 
whether or not to stop the port.  While it is not necessary to stop the port just to 
view it, you must stop the port to configure it.    

Do the following to configure fax ports: 

1. Click the Configure toolbar button  and select the Fax Ports tab (Figure 4-
1).  (You can also select Configure…Ports…Fax Ports or Configure…All 
Settings…Fax Ports.) 
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Figure 4-1.  Configure Fax Ports Tab 

2. To configure the port, highlight the port and click the Configure button to 
display the Fax Port dialog (Figure 4-2).  (If the port is not stopped, you are 
prompted whether to stop the port since you cannot configure a port unless you 
first stop it.  You can, however, view the configuration in read-only mode 
without stopping the port.) 

 

Figure 4-2.  Fax Port Dialog  
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Note:  You can also display the Configure Fax Port dialog box by either clicking 
the View Fax Ports toolbar button (or selecting Fax Ports from the View pull-down 
menu), then double-clicking the specific port you want to configure. 

3. Specify the appropriate information as follows: 

Port Mode – either Transmit/Receive if both outbound and inbound fax traffic 
are to be handled over this port; Transmit Only if only outbound traffic is 
allowed, with no incoming calls answered; Receive Only if only inbound fax 
traffic is to be handled over this port, with no outbound fax jobs queued to the 
port.  Note that you must specify Receive Only when connecting the fax port to 
a DID or TIE line trunk. 

Auto Disable – Check to cause the fax port to auto disable in the event of a 
phone line failure (two consecutive no-dial-tone errors). The server will then 
restart the auto-disabled port after 1 hour to check the line. If the alarm-events 
function is configured to monitor a fax port problem,  the auto-disabled port 
would also trigger an alarm.  (Refer to the "Configuring Alarm Management 
Events" section later in this chapter for more information.) 

Port CSID – enter an up-to-20 character  alphanumeric string (alpha characters 
must be UPPERCASE) that is returned to the sender to identify the called 
machine.  This ID is usually set to a company name or phone number associated 
with the port. 

Auto Route Method – set to None if no auto routing is configured; DTMF for 
DTMF routing; DID for DID routing.  Refer to the “Configuring Inbound Routing” 
section for more information on specifying auto routing, including routing 
incoming faxes to a locally-attached printer. 

Default Route Id – Specify default inbound routing digits (extension) to be 
assumed if no auto-route digits are received. Covers both DTMF and DID 
routing. 

Auto Start – Check to set port so that it starts automatically next time the 
service is started.  Note that stopping the port will disable Auto Start, and you 
will have to re-check this box. 

Advanced… – click to configure advanced fax port parameters 

Configure Advanced Fax Port Parameters 
When you configure advanced fax port parameters, you work directly in the 
configuration file and can edit parameter values, add parameter values and delete 
parameter values.  (Typically, you should not have to access the configuration file 
unless so advised by Biscom support personnel.) 

Do the following to configure advanced fax port parameters: 
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1. Click the Configure toolbar button , and select the Fax Ports tab.  (You can 
also select Configure…Ports…Fax Ports or Configure…All Settings…Fax Ports.) 

2. To configure the port, highlight the port and click the Configure button.  The 
Fax Port dialog is displayed (Figure 4-2). 

3. Click the Advanced button to display the configuration file with the advanced 
parameter values (Figure 4-3). 

 

Figure 4-3.  Advanced Fax Port Parameter Configuration 

To delete a parameter value, highlight it and click the Delete button. 

To edit a parameter value, highlight it and modify the parameter and/or value in 
the boxes provided.  Click the Set button to save the newly-modified parameter 
value. 

To add a value, enter the new parameter and its value in the boxes provided.  
Click the Set button to save the newly-added parameter value (which is placed in 
the parameter list in alphabetical order). 
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Configure Host Ports 
When you select the Configure Host Ports function, you can either make changes to 
the port configuration or view the configuration in read-only mode.  For that 
reason, you are prompted whether or not to stop the port.  While it is not necessary 
to stop the port just to view it, you must stop the port to configure it. 

Do the following to configure host ports: 

1. Click the Configure toolbar button , and select the Host Ports tab (Figure 
4-4).  (You can also select Configure…Ports…Host Ports or Configure…All 
Settings…Host Ports.) 

 

Figure 4-4.  Host Ports Tab 

2. To configure the port, highlight the port and click the Configure button.  (If the 
port is not stopped, you are prompted whether to stop the port since you cannot 
configure a port unless you first stop it.  You can, however, view the 
configuration in read-only mode without stopping the port.)  The Host Port 
dialog is displayed (Figure 4-5). 
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Figure 4-5.  Host Port Dialog 

Note:  You can also display the Configure Host Port dialog box by either clicking 
on the View Host Ports toolbar button (or selecting Host Ports from the View pull-
down menu), then double-clicking the specific port you want to configure. 

3. Specify the appropriate information as follows: 

Connection Mode – TCP for communication over Ethernet or token ring TCP/IP 
connections. The port is dedicated to a single FAXCOM Queue. Generally used to 
send test faxes, except in some legacy environments where each FAXCOM Queue 
communicates with a dedicated TCP port on a FAXCOM Server; TRAN for 
communication over TCP/IP to enable multiple FAXCOM queues to share the 
same host port. Generally considered the main production port; COM for 
communication via serial port (COM 1 or COM2) to a single FAXCOM queue. 
Generally a much slower connection used in legacy environments, such as one 
without TCP/IP; SSL for Secure Sockets Layer communication (requires manual 
configuration for which you should contact Biscom Technical Support). 
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Notes:  By default, the FAXCOM Server is shipped with host ports set to TRAN 
connection mode, 6001 as the TCP Port Number, and a default inbound route set 
to deliver received faxes to the first-connected TRAN session.   
If you are using the Least Cost Routing option, be sure to select TRAN as the 
Connection Mode when configuring the remote FAXCOM server on the remote 
side.  

TCP Port Number – (enabled only if you selected TCP or SMTP for Connection 
Mode); specify the TCP port number used to listen for incoming connections 
from the Ethernet/Token Ring network – of a value equal to or greater than 
6000. 

Host Port Baud Rate – enabled only if you selected COM1 or COM2 as the 
connection mode.  The baud rate (bits per second), is the speed of data transfer 
and should match the baud rate specified on the remote system the FAXCOM 
server is connected to via the serial port. To specify the remote port settings, 
use the HyperTerminal application included in Windows.  
(Start…Accessories…Communications…HyperTerminal.)  Baud rate should be set 
to the highest rate supported at both ends. 

Flow Control – enabled only if you selected COM1 or COM2 as the connection 
mode.  Settings in this box must correspond to the remote system the FAXCOM 
server is connected to via the serial port.  To specify the remote port settings, 
use the HyperTerminal application included in Windows. 
(Start…Accessories…Communications…HyperTerminal.) 

Xon-Xoff - select a compatible flow control protocol for proper operation of 
the asynchronous serial port. (Sometimes called software handshaking.) 

Hardware - select to invoke hardware handshaking. This is the standard 
method of controlling data flow between a computer and a serial device. 

Half HP - Select to connect to an HP 3000 proprietary half duplex flow 
control. 

None - Select to disable flow control. (Not recommended under most 
circumstances, except at very low baud rates.) 

Session – (enabled only if you selected TRAN for Connection Mode); Default for 
new sessions is displayed before a session is selected to enable you to use the 
specified settings for any new sessions that connect; otherwise, select the 
specific session to configure its own settings  

Note that in most cases your front-end fax service (FAXCOM Suite for 
Windows/FAXCOM for Domino) automatically selects the values for the following 
settings: 

Port TSID – Transmitting Station Identifier sent to the remote fax machine to 
identify the sender, typically the phone number of the sending device, that is 
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displayed on the console of the remote fax machine while the fax is being sent, 
and is also printed out in the remote fax machine logs.  Alpha characters must 
be uppercase.  

Header Text Enabled – check to implement printing of header text you specify in 
the Header Text field) on the top line of each transmitted fax page.  

Header Text – up to 32 characters that are printed on the top line of each 
transmitted fax page if the Header Text Enabled option is checked.  Typically, 
describes the location or company name that originated the fax.  

Header Page Numbering – check to enable printing of page numbering on top 
line of each page. 

Header Time/Date – check to enable printing of time and date stamp on top line 
of each page. 

Generate Searchable – active only if the OCR option is installed and enabled, 
check to specify that a Host Port or Session receive faxes as searchable TIFF/PDF 
files 

Note:  For more information on performing OCR on received faxes and generating 
searchable files, refer to the “Performing OCR and Generating Searchable 
Documents” section immediately below.  

Advanced… – click to configure advanced host port parameters 

Performing OCR and Generating Searchable Documents 
The OCR option enables you to perform Optical Character Recognition on received 
faxes in order to generate searchable documents – either searchable TIFF files or 
searchable PDF files.  The received faxes can then be searchable either by individual 
FAXCOM Suite for Windows/FAXCOM for Domino recipients, or programmatically by 
the FAXCOM Suite for Windows Advanced Fax Routing option, whereby incoming 
faxes can be automatically routed according to data extracted from the fax itself. 

You do the following to implement the OCR function: 

1. If the option was not installed/configured at Biscom,  click the Configure toolbar 

button , select the Options tab (Figure 4-16), select (check) the OCR 
checkbox, and specify your OCR option authorization code. 
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Note:  Because OCR is a CPU-intensive function, you enable the OCR option for the 
FAXCOM Server itself on the Options tab.  You then specify just which Host 
Port/Session will actually be receiving searchable files on the Host Port dialog 
(Figure 4-5) for delivery to a particular FAXCOM Queue.  In that way, you 
selectively implement the function as needed.  

2. Refer to the “OCR Option System Requirement Guidelines” section later in this 
chapter for more information on the CPU power needed to perform OCR of 
received faxes. 

3. When configuring a Host Port on the Host Port dialog (Figure 4-5), select (check) 
the Generate Searchable checkbox to specify that the Host Port/Session you are 
configuring deliver searchable files to the FAXCOM Queue(s) to which it routes 
received faxes. 

4. Within your front-end product, confirm that you are running the version 
required for receiving searchable documents (FAXCOM Suite for Windows 
Release 9.17 or FAXCOM for Domino Release 8.3). 

5. Within your front-end product, configure the format or received faxes, TIFF or 
PDF, to generate either searchable TIFF or searchable PDF files.  If necessary, 
refer to the FAXCOM Suite for Windows Administrator’s Guide or the FAXCOM for 
Domino Administrator’s Guide for information on specifying receive fax options 
for the FAXCOM Queue to which the Host Port/Session is delivering received 
faxes. 

Configure Advanced Host Port Parameters 
When you configure advanced host port parameters, you work directly with the 
configuration file and can edit parameter values, add parameter values and delete 
parameter values. 

Do the following to configure advanced host port parameters: 

1. Click the Configure toolbar button , and select the Host Ports tab.  (You 
can also select Configure…Ports…Host Ports or Configure…All Settings…Host 
Ports.) 

2. To configure the port, highlight the port and click the Configure button. The 
Host Port dialog is displayed (Figure 4-5). 

3. Click the Advanced button to display the configuration file with the advanced 
parameter values (Figure 4-6). 
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Figure 4-6.  Advanced Host Port Parameter Configuration 

To delete a parameter value, highlight it and click the Delete button. 

To edit a parameter value, highlight it and modify the parameter and/or value in 
the boxes provided.  Click the Set button to save the newly-modified parameter 
value. 

To add a value, enter the new parameter and its value in the boxes provided.  
Click the Set button to save the newly-added parameter value (which is placed in 
the parameter list in alphabetical order). 

Configure Server Settings 
When you configure the server, you specify certain configuration parameters that 
affect the entire operation of FAXCOM Server. 
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Note: In many cases you can change a parameter with the change taking effect 
immediately; it is standard, however, to change configuration settings when the 
service is stopped, and then to restart the service after making changes. 

1. Click the Configure toolbar button , and select the Server Settings tab 
(Figure 4-7).  (You can also select Configure…Server Settings or Configure…All 
Settings…Server Settings.) 

 

Figure 4-7.  Server Settings Tab 

2. Specify the appropriate settings, as follows: 

Installed Ports 

Fax Ports – number of fax ports to enable; on the Options tab (Figure 4-16), you 
can change the maximum number of fax ports you can enable up to the 
maximum number supported by your Authorization Code 

Host Ports –  number of host ports you plan to use.  FAXCOM Server ships with 
one host port configured for TCP mode and one host port configured for TRAN 
mode; all FAXCOM Server models, however, support up to 6 host ports. 

Inbound Routes 

Time Stamp – check this box to specify that all received faxes automatically be 
stamped with the time they were received 
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Number of DID digits – number of digits to be detected for inbound routing.  
The FAXCOM server is shipped with a default value of 4 for this parameter, 
which you can change if appropriate 

Accept Shorter DIDs – leave unchecked (which is the default), to specify that the 
FAXCOM Server not accept an incoming fax with fewer DID digits than are 
specified in the Number of DID Digits field.  Check the option to specify that the 
FAXCOM Server does accept an incoming fax with fewer DID digits than are 
specified in the Number of DID Digits field. 

Job Tracking 

Server – specify the computer name or IP address of the machine where the Job 
Tracking service is running, where FAXCOM Job Tracking is a service that 
monitors the progress of both outbound and inbound faxes.  To specify a 
secondary, i.e., backup, Job Tracking server, follow the first entry with a comma 
or space followed by the computer name or IP address of the secondary 
machine. 

Note:  In the event you need to upgrade to Version 2 of Job Tracking from Version 
1 (or downgrade to Version 1 from Version 2), refer to the “Specify the Job 
Tracking Protocol” section immediately following. 

TX – Check this option to enable Job Tracking for transmitted faxes. 

RX – Check this option to enable Job Tracking for received faxes. 

SMTP 

Mail From Full Name – enter the display name an SMTP recipient (usually an 
administrator) sees when viewing an e-mail message (usually an e-mail alarm 
notification) from the FAXCOM Server. 

Mail From E-mail Address – specify an SMTP "from" mailbox for messages sent 
by the FAXCOM Server. The default value is faxcom. Enter a valid SMTP address 
such as admin@foo.com. 

SMTP Server – specify the name or IP address of the SMTP server to use.  If this 
field is left blank, then the FAXCOM Server will attempt to locate a server for 
each message using DNS and the host specified after the “@” in the destination 
SMTP address. 

SMTP Login – click this button to specify your SMTP server user name and 
password. 

Service Log Level – refers to the general service log (ims_log). Enter a value from 
0-7, where 0 is the most verbose and 7 the least. The recommended level is the 
default of 4.  Setting a value of 0, 1, 2 or 3 can cause so much information to be 
written to the logs that server throughput may be degraded.  Consequently, a 
value of 0 through 3 should be used for troubleshooting purposes only. At a 
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value of 7, the  ims_log provides only critical errors (and less detail than at lower 
levels), but the log will cover a much longer time span. 

Diagnostic Mode – check this box to change the service log level to an 
extremely verbose mode (the equivalent of service log level 1) and to change the 
number of saved ims_log.old files to 100.  Checking this box does not change 
the service log level you specified; the verbose display is only temporary and 
ends when you uncheck this box.  Use this box for troubleshooting only.  

LDAP 

LDAP Server 1 – specify the IP address or name of the Primary LDAP server to be 
queried for inbound routing of faxes to SMTP mailboxes; this is a required field; 
if specifying a name for the server – rather than an IP address – an entry must be 
defined for the server in a DNS or host table. 

LDAP Server 2 – specify the IP address or name of the Secondary LDAP server to 
be queried in the event the Primary Server cannot be contacted or does not 
respond; this is an optional field; if specifying a name for the server – rather 
than an IP address – an entry must be defined for the server in a DNS or host 
table. 

LDAP Port – the default is the standard TCP/IP port on which LDAP service is 
provided; this value applies to both LDAP servers if you are using two.  This 
parameter can be changed if appropriate, but both LDAP servers must be on the 
same standard port.  If your LDAP server(s) require login, click the LDAP Login 
button to enter your user name(s) and password(s). 

LDAP BASE DN – specify the Distinguished Name (DN) of the entry at which to 
start the search, for example, o=Biscom. 

LDAP Login… –  click to display the LDAP Login dialog (Figure 4-8) and  specify 
the appropriate user name(s) and password(s) for logging on to the LDAP 
server(s). 
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Figure 4-8.  LDAP Login Dialog  

Advanced… – click to configure advanced server setting parameters 

Specify the Job Tracking Protocols 
There may be cases in which you have to specify the specific protocols to use for Job 
Tracking, where there is the older Protocol 1 and the more recent Protocol 2.  When 
peforming an upgrade of the FAXCOM Server, for example, it is necessary to specify 
the use of Protocol 2.  When using Job Tracking with an older FAXCOM Server that 
does not support Protocol 2, you may have to specify use of Protocol 1. 

Do the following to specify which Job Tracking Protocol to use: 

1. On the Server Settings tab (Figure 4-7), click the Advanced button to display the 
configuration file with the advanced parameter values (Figure 4-9). 

2. Enter the new parameter and its value in the boxes provided, either 
Job_Track_Protocol = “1” or Job_Track_Protocol = “2”. 

3. Click the Set button to save the newly-added parameter value (which is placed in 
the parameter list in alphabetical order). 
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Configure Advanced Server Parameters 
Typically, you should not have to configure advanced server parameters, and this 
information is primarily provided for your information. 

When you configure advanced server parameters, you work directly with the 
configuration file and can edit parameter values, add parameter values and delete 
parameter values. 

Do the following to configure advanced server parameters: 

1. Click the Configure toolbar button , and select the Server Settings tab 
(Figure 4-7).  (You can also select Configure…Server Settings or Configure…All 
Settings…Server Settings.) 

2. Click the Advanced button to display the configuration file with the advanced 
parameter values (Figure 4-9). 

 

Figure 4-9.  Advanced Server Parameter Configuration    

To delete a parameter value, highlight it and click the Delete button. 
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To edit a parameter value, highlight it and modify the parameter and/or value in 
the boxes provided.  Click the Set button to save the newly-modified parameter 
value. 

To add a value, enter the new parameter and its value in the boxes provided.  
Click the Set button to save the newly-added parameter value (which is placed in 
the parameter list in alphabetical order). 

Note:  Refer to Appendix B for more information on a number of advanced 
capabilities you can implement through the Server Settings advanced 
configuration file. 

Configure TR1034 Settings 
Note:  Biscom – as does Dialogic– strongly recommends use of a Channel Service 
Unit (CSU) for T-1 installations connecting directly (not through a PBX) to the 
phone company.  For a fuller explanation of the functions provided by a CSU, refer 
to the Dialogic Knowledgebase Article #1146. 

During the installation of the FAXCOM Server software, you were asked to specify 
information for your telephone line type (TI/PRI/E1).  If your fax board is a TR1034, 
those settings are reflected on the TR1034 Settings tab of the Configure All Settings 
window. 

Note: This tab will not be visible if you do not have a TR1034 fax board. 

In the event you need to change the information you specified during the 
installation, do the following: 

1. Click the Configure toolbar button  and select the TR1034 Settings (Figure 
4-10).  You can also select Configure…All Settings…TR1034 Settings.  Note that 
the fields on the tab change depending on your selection of Telephone Line 
Type. 
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Figure 4-10.  TR1034 Settings Tab (T1) 

2. Change settings where appropriate, keeping the following in mind: 

• Select the Debug logging option only if so advised by Biscom Support personnel. 

• Select the V.34 Mode option in order to transmit faxes at a transmission speed 
faster than 14.4 kb/s and up to 33.6 kb/s. 

• If you add or remove TR1034 fax boards, you will need to make sure the number 
of telephone line interfaces matches the number of TR1034 cards. 

• If you have either T1 or PRI phone line type, you will have to configure the cable 
length.  Cable length is the one aspect of T1/PRI setup you were not asked to 
specify during the installation of the FAXCOM Server software.  If the length of 
your cable exceeds 133 feet, change the default setting to the setting that most 
closely corresponds to the actual length of your cable. Set the length as 
accurately as possible since an incorrect setting affects signal quality and proper 
operation of the board.  

• Other settings must correspond to the telephone line type as determined by your 
telephone company. 

3. Restart the FAXCOM service for any changes to take effect. 
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Configure SR140 Settings 
In the event you need to view/modify SR140 settings, do the following: 

1. Click the Configure toolbar button  and select the SR140 Settings (Figure 
4-11).  You can also select Configure…All Settings…SR140 Settings. 

 

Figure 4-11.  SR140 Settings 

2. Make the appropriate selections according to your implementation: 

Licensed channels – a read-only field that displays the number of fax ports for 
which you are licensed. 

License Manager – click this button to display the Brooktrout License Manager, 
with which to activate your SR140 license. 

Debug logging – select this option only if so advised by Biscom Support 
personnel. 

V.34 Mode – select this option in order to transmit faxes at a transmission speed 
faster than 14.4 kb/s and up to 33.6 kb/s. 

Mode – select T.38 to use T.38 only; select T.38 + G.711 to try to use T.38, 
falling back to G.711 if unsuccessful; select G.711 to use G.711 fax pass-
through. 

Call Control – select the call control method used for Voice Over IP, either: 
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SIP for the Session Initiation Protocol, a text-based protocol, similar to HTTP and 
SMTP, designed to manage multimedia sessions over the Internet; while SIP is 
responsible for determining the peer IP address and port number on which to 
communicate, it does not perform the actual physical transport of the media, 
which is typically done via TCP/IP. 

H.323 for the standard that describes how multimedia communications occur 
between terminals, network equipment, and services, and which is part of a 
larger group of ITU recommendations for multi-media interoperability called 
H.3x.  H.323 addresses call control and management for both point-to-point 
and multipoint conferences as  well as gateway administration of media traffic, 
bandwidth, and user participation. 

Call Control Variant – select either Default, Cisco CallManager, or Avaya, and 
typically Default. 
Round Robin – if you have two or more entries for Gateway IP Address, select 
this option to specify a form of load balancing whereby faxes are cycled to each 
gateway on a rotating basis. 

Be aware that In the event a gateway is unavailable, the application marks that 
gateway as unavailable for 10 minutes before trying again – regardless of whether 
or not the Round Robin option is selected.    

T.38 Version – a field that is activated when V.34 Mode is not checked, and 
which enables you to select the T.38 Version, either 0, 1, 2, or 3.  

Gateway IP Address – specify the IP Address of the Cisco router in use and click 
the Add button to add it to the list.  Use the Move Up and Move Down buttons 
as appropriate to move entries within the list (where the topmost entry is the 
one that will be used); click the Remove button to delete a selected entry from 
the list. 

Note that you can specify a machine name in the Gateway IP Address and Local IP 
Address fields and the application will convert the name to the corresponding IP 
Address. 

IP Preference – select either IPV4 Only, IPV6 Only, IPV4 Preferred, IPV6 Preferred, 
being aware of the following considerations: 

Unless you have configured the system to use both IPV4 and IPV6, you must 
select IPV4 Only. 

If the application is unsuccessful using either IPV4 Preferred or IPV6 Preferred, it 
will fall back to using IPV4 Only.  

Local IP Address – specify the IP Address of the system, being aware that you 
can enter a machine name that will be converted to an IP Address. 

H.323 Gatekeeper IP Address – if you have selected H.323 for Call Control, 
specify the IP Address of the H.323 Gatekeeper. 
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Configure Alarm Management Events 
You can configure the Alarm Management function to automatically monitor certain 
significant events, as follows: 

1. Click the Configure toolbar button , and select the Alarm Events tab 
(Figure 4-11.  (You can also select Configure…Alarm Events or Configure…All 
Settings…Alarm Events.) 

 

Figure 4-11.  Alarm Events Tab 

2. Check the events you want monitored.  The events are: 

Host Link Down – TCP link has disconnected abnormally 

Fax Port Problem – a fax port hardware error was reported and the port has 
been marked out-of-service 

Bad Phone Line – a bad phone line, or phone cable, has been detected 

Bad Fax Board – a fax board has been marked out of service due to a 
detected hardware malfunction 

Low Disk Space – fax server disk is running low in disk space 

Internal Error – an internal error has occurred and should be reported to 
Biscom if it occurs repeatedly 
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FAXCOM Restart – fax server has been restarted 

LCR Link Error – an error has been detected with the link to the remote 
server 

Translation Server Error – an error has been detected with the connection to 
the Translation Server (if the Translation Server is an external machine), or 
the Translation Server has failed to successfully convert a document  

Host Generated via FCL – a LAN/host-based application generated an alarm 
via FCL 

Session Timeout – check to monitor whether a LAN/host session has not 
reconnected to the FAXCOM since the specified timeout; specify the timeout 
value in seconds 

Server Metrics – check to specify that an alarm be generated whenever a set 
threshold is exceeded for certain key server parameters which you specify by 
clicking the Specify button and displaying the Specify Server Metrics dialog 
box (Figure 4-12). 

 

Figure 4-12.  Server Metrics Dialog 
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Specify Server Metrics to be Monitored 
You can monitor server metrics, whereby an alarm is generated whenever a set 
threshold is exceeded for the following key server parameters: 

Queue Size 

Global – contains all outgoing jobs in all external queues of FAXCOM host 
applications. The default threshold for the global outbound queue is 1000 jobs 
and is polled by the server in 30-minute intervals. The default setting should be 
appropriate for most configurations; however, you can change it to a reasonable 
value which exceeds the largest anticipated normal queue size. The global 
queue size also includes jobs in the local queue. If these queues grow 
exceedingly large, it could indicate either a bottleneck (more lines are required), 
a phone line problem, or a server malfunction which prevents the processing of 
jobs. 

Local – contains staged jobs in the FAXCOM server’s internal queue ready to be 
sent to an external queue. Most jobs are outbound since inbound jobs reside in 
the queue only briefly during the translation and routing phase. The default 
threshold is 500 jobs and is polled by the server in 30-minute intervals. While 
the default setting should be appropriate for most configurations, you can 
change it to be a reasonable value which exceeds the largest anticipated normal 
queue size. If this queue grows exceedingly large, it could indicate either a 
bottleneck (more lines are required), a phone line problem or a server 
malfunction which prevents the processing of jobs. 

Inbound – inbound jobs moving from the FAXCOM to applications associated 
with host ports and host sessions; these queues serve as interim repositories of 
fax data since the data is periodically polled and picked up by the front-end fax 
services (FAXCOM Suite for Windows, FAXCOM for Domino); the threshold 
defaults to 100 jobs, and the threshold is polled by the server in 30-minute 
intervals. 

When changing the threshold setting, specify a reasonable value that exceeds 
the largest anticipated normal queue size.  

If these queues grow exceedingly large, it could indicate either a bottleneck 
(more lines are required), or an application malfunction (i.e., the application is 
down). 

Note:  Be aware that the threshold value for Global and Local applies to the sum of 
jobs from all queues (i.e., all host ports/host sessions), while the threshold value 
for Inbound applies to each queue individually. 

Rx Fax Port Inactivity – any enabled inbound fax lines that are sitting idle for 
extended periods of time.  This value defaults to 48 hours (to reflect a weekend 
of inactivity) and the threshold is polled by the server in 2-minute intervals.  It is 
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recommended that this value be set to a reasonable value that exceeds the 
longest anticipated idle time interval. 

If the idle time is too high, it could indicate a phone line malfunction.  

Fax Port Error Rate 

Rx – an error rate that is a percentage of the total attempts per hour per fax 
port, in 1 of 3 categories:  All Errors (Connect and Non-Connect);  Connect 
Errors Only; Non-Connect Errors Only.  This value defaults to 25% of the total 
attempts of the specified error type, and a fax port must have processed a 
minimum of 20 jobs in an hour before its transmission error rate is calculated. 

A high error rate could indicate a phone line or fax port hardware malfunction. 

Tx – an error rate that is a percentage of the total attempts per hour per fax 
port, in 1 of 3 categories:  All Errors (Connect and Non-Connect);  Connect 
Errors Only; Non-Connect Errors Only.  This value defaults to 25% of the total 
attempts of the specified error type, and a fax port must have processed a 
minimum of 20 jobs in an hour before its transmission error rate is calculated.   

A high error rate could indicate a phone line or fax port hardware malfunction. 

 Configure Alarm Notification Methods 
You can configure the Alarm Management function to notify you of a monitored 
event, as follows: 

1. Click the Configure toolbar button , and select the Alarm Notifications tab 
(Figure 4-13).  (You can also select Configure…Alarm Notifications or 
Configure…All Settings…Alarm Notifications.) 
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Figure 4-13.  Alarm Notifications Tab 

2. Check the notification methods you want to use, specifying the necessary 
information, as follows: 

Console Beep 

SNMP Trap – for which you must specify 

Specific Base Trap – the base trap value, such as 100 

Multiple Trap – when checked, specifies that each event generates a unique 
trap which is indexed from the Specific Base Trap value as follows: 

Base Trap + Event Index 

The Event Index values are automatically assigned by the system as follows: 
Alarm Event 

Type 
Description Trap Index Number 

10 Host link down 0 

11 Host via FCL command 10 

13 Diagnostic alarm 11 

14 Session time-out 5 

20 Fax port problem 1 

21 Phone line out of service 2 
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23 Bad fax board 3 

30 Low disk space 4 

31 Internal error 6 

33 FAXCOM restart 7 

34 LCR-related problem 8 

40 Translation Server error 9 

50 Rx fax port error rate 12 

51 Tx fax port error rate 13 

52 Rx line idle 14 

53 Internal Tx queue size 15 

54 Internal Tx (local) queue size 16 

55 Global Tx queue size 17 

For example, if MultipleTrap is checked, and the Specific Base Index value is 
specified as 100, if a Session Time-out event is detected, an SNMP trap value 
of 100+5 – to equal 105 – is generated 

Note:  If using SNMP alarming on the latest Microsoft operating systems, you must 
do the following to install and configure the SNMP service: 
Select Control Panel…Programs…Turn Windows features on or off; select (check) 
the Simple Network Management Protocol (SNMP) service and click OK. 
Once you have added the SNMP service, select Control Panel…Administrative 
Tools…View local services; select the SNMP service, right-click and select 
Properties; select the Traps tab; enter the appropriate information, keeping in 
mind that you can enter multiple IP addresses for multiple destinations. 

Print – for which you must specify 

Printer Name – name of printer (as created and defined through the Control 
Panel Printer applet) 

E-mail – for which you must specify 

SMTP E-mail Address – any valid Internet user domain name of the Mailbox 
to receive the SMTP mail message, such as billa@faxcom.com 

Page – for which you must specify 

Pager Number – paging system access phone number, followed by one or 
more commas (each of which denotes a 2-second pause), followed by a 
numeric string (any combination of numbers 1 through 9) to denote a 
generic FAXCOM alarm event 

Modem Speed – speed of connected modem (either 300, 2400, or 9600) 
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Modem Port – async serial port to be used for pager modem connection 
(either COM1, COM2) 

Custom notification command – click the Enable check box to specify a 
program to be invoked when an alarm is generated; a file containing the text of 
the alarm is then passed as an argument to the specified program  

Configure Inbound Routing 
The FAXCOM Server supports the following methods, i.e., criteria, for inbound 
routing of faxes: 

Fax Port – whereby all faxes over a given port or range of ports are routed to a 
specified destination type 

Dialed Digits – whereby all faxes are routed to a specified destination type 
according to the phone number dialed; this option includes Dual Tone Multi 
Frequency (DTMF); Direct Inward Dial (DID) that requires the lines to be 
configured as receive-only; PBX TIE Line, an option that uses DID trunk 
interfaces connected directly to an on-premises Private Branch Exchange (PBX); 
with this option, the PBX (not the FAXCOM Server) terminates the DID trunks. 

TSID – whereby all faxes received from the specified Transmitting Station 
Identifer (TSID) are routed to the specified destination type   

Caller ID – whereby all faxes received from the specified sending telephone 
number are routed to the specified destination type 

LDAP Query – whereby an LDAP query is run for each received fax 

MS Exchange UM – whereby faxes will be delivered to an email destination 
specified by MS Exchange UM 

You can choose from the following Destination Types when configuring the routing 
methodsHIDD_INROUTINGPARAMS_DLG: 

Host Port, Session, Printer, SMTP E-mail, SMTP E-Mail via LDAP, FTP, UNC, 
Quarantine, Hang up, SFTP 

If no Inbound Routing entries are configured, routing is done to the Default Route, 
which is created automatically by the first fax queue that attempts to pick up faxes 
from the fax server.  If you have just one fax server and one fax queue, you can 
simply accept this default route.  If, however, you have multiple servers/queue, you  
can change the Default Route on the Inbound Routes tab. 

Do the following to configure the FAXCOM Server for your inbound routing 
interface: 

1. Click the Configure toolbar button , and select the Inbound Routes tab 
(Figure 4-14).  listing any currently-configured Inbound Routing entries.  (You 
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can also select Configure…Inbound Routing or Configure…All Settings…Inbound 
Routes.) 

 

Figure 4-14.  Inbound Routes Tab 

2. Either highlight an existing entry and press the Edit button, or press the Insert 
button to insert a new entry.  The Inbound Route dialog (Figure 4-15) is 
displayed. 
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Note:  Be aware that a new entry will be inserted above the current cursor position 
on the Configure Inbound Routing dialog box list AND THE ORDER OF THE ENTRIES 
IS CRUCIAL since the routing is done according to the first match found in the list.  
Therefore, if appropriate, you can always highlight an entry on the list and click 
either the Up or Down button to move it.  

 

Figure 4-15.  Inbound Route Dialog 

Note that the fields on the Inbound Route dialog change depending on what you 
select for Method and Destination Type, as follows: 

3. In the Route By box, select either Fax Port for Fax Port routing, Dialed Digits for 
DTMF, DID or PBX Tie Line routing, TSID to route on the Transmitter Subscriber 
ID (TSID), Caller ID to route on the Sending telephone number, LDAP Query for 
routing on directory look-ups, or MS Exchange UM for delivering to an email 
destination specified by MS Exchange UM. 

If you selected Fax Port, specify the port(s) in the from and to boxes. 
If you selected Dialed Digits, specify the extension number or range of 
extension numbers, using the number of digits specified in the Inbound Route 
Number of Digits field on the Server Settings tab (Figure 3-3). 

If you selected TSID, specify the TSID in the Match TSID box.  The TSID is 
generally found in the metadata of a fax already received.  You can match exact 
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alphanumeric strings or use one of two wildcard characters: an asterisk (*) to 
specify a string of matching alphanumeric characters (e.g. to route all faxes 
from area code 978, enter 978* in the Match TSID box) or a question mark (?) to 
specify and match any character at a single position in a string. 

If you selected Caller ID, specify a digits-only string in the Match Caller ID box. 

If you selected LDAP Query , specify a phone mask with x characters and 
possibly dots and an LDAP query.   For each received fax, the query is run.  If no 
matches are found, the next rule is evaluated.  If matches are found, the query 
looks at the specified attribute (which in the example shown in Figure 4-16 is 
the Session Name Attribute) and sends the incoming job to that session (or 
sessions if multiple matches are returned). 

The DIDs are formatted as follows:  all characters except “x” and “.” are 
preserved as is.  The “x” characters are replaced with digits from the received 
DID.  The phone mask is needed because the number in AD is typically 
formatted. 

Use the following examples as a guide: 

• The DID digits received are 9783672748, but the number in AD is 
formatted as (978) 367-2748, therefore requiring the phone mask (as 
shown in Figure 4-16). 

• The DID digits received are 9783672748, but the number in AD is 
specified as x2748, therefore requiring the phone mask to be 
……\xxxxx, which specifies skip the first 6 digits of the received DID, 
insert an x (which is escaped with a back slash), and route on the last 
four digits of the received DID.         
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Figure 4-16.  Route by LDAP Query 

Note:  Through the Fax Port, Dialed Digits, LDAP Query, and MS Exchange UM 
methods, faxes are routed based on where they're going to (known recipients) By 
routing inbound faxes via TSID or Caller ID, faxes are routed based on where 
they're coming from.  (The latter methods are rarely used and, then, mostly to 
block unwanted inbound faxes.)   

If you selected MS Exchange UM, it is not necessary to specify any information 
as routing is done by MS Exchange UM. 

4. In the Route Settings box, check the Final Route checkbox to specify that a 
Destination Type you will configure in the Route Destination Destination Type 
field is the final route, with no more attempts at matching routing method and 
destination.  The Final Route option is available for every Destination Type 
except Hang up. 

5. In the Destination Type box, select the appropriate destination from the pull-
down list. 

If you selected Host Port (to route incoming faxes to a FAXCOM Queue or your 
own FCL application), specify the host port number in the Host Port box. 
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Note:  If you want to configure the Host Port to receive faxes as searchable PDF 
files, check the Generate Searchable check box on the Host Port dialog (Figure 4-
5). 

If you selected Session (to route incoming faxes to a FAXCOM Queue or your 
own FCL application), select a session name from those available in the Session 
Name box. 

Note:  If you want to configure the Session to receive faxes as searchable PDF 
files, check the Generate Searchable check box on the Host Port dialog (Figure 4-
5). 

If you selected Printer (to route incoming faxes to a specific local or network 
printer), specify the destination printer name in UNC notation in the Printer 
Name box, select the printer type in the Printer Data Type box, and 
check/uncheck the  Banner box according to whether or not to print a banner 
page. 

If you selected SMTP E-mail (to route incoming faxes to an SMTP email address), 
specify any valid Internet user domain name to receive the mail in the SMTP E-
mail Address box, select the format of the fax attachment in the Attachment 
Type box, and check/uncheck the Banner box according to whether or not to 
create a text file to which to attach the fax. 

If you selected SMTP E-Mail via LDAP, specify the query search string to use in 
the LDAP Search Filter box.  Search string syntax for the search filter is rigid – 
click the Sample button to see an example. Enter the string in the following 
format: 

(keyword=matchstring) 

where keyword is a keyword (such as "facsimiletelephonenumber" or "mail") 
from LDAP database schema, and where matchstring is an exact value for a 
single user or a construct containing 1 of 4 substitution strings (often$RID) for 
multiple users: 
Substitution String What it queries and routes by: 

$RID Dialed Digits 

$LINE Fax Ports 

$TSID TSID 

$CALLERID Caller ID 

The substitution string is based on the Route By method as specified above. 

If the LDAP lookup fails, the inbound fax is routed to the entry in the Default 
SMTP E-mail Address field.  Specify an address that is active and that will 
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periodically be checked by an administrator who will forward and/or reroute 
faxes delivered there.  

Select the format in which to attach the fax in the Attachment Type box, and 
check/uncheck the Banner box according to whether or not to create a text file 
message to which to attach the fax. 

If you selected FTP (to route incoming faxes to a destination directory on a 
specific server on the internal network), specify the IP address or host name of 
the FTP server in the FTP server box; if appropriate, change the default of Port 
21; specify any User Name and Password required to login to the FTP server in 
the User Name and Password boxes, the type of file to route to the FTP server in 
the File Type box, the specific directory on the FTP server in which to deposit 
the file in the Directory box (otherwise, it is deposited in the root), and 
check/uncheck the Banner box according to whether to create a banner page. 

If you selected UNC (to route incoming faxes to an internal file directory), specify 
a destination directory in UNC format, or browse for a folder using the Browse  
button, the file type in the File Type box, and check/uncheck the Banner box 
according to whether to create a banner page. 

If you selected Quarantine or Hang up (to route incoming faxes to a local 
destination [drive:\u\Quarantine] where you can identify possible spam faxes, or 
to hang up and not route faxes), there are no settings to specify.  To view, 
delete, and/or manually process quarantined faxes, refer to Chapter Six, “Install 
and Use Qdoctor.”  Senders of faxes to the Hang up destination receive an error 
message. 

If you selected SFTP (to route incoming faxes are routed to a destination 
directory on a specific server over a secure encrypted network), specify the IP 
address or host name of the secure FTP server in the SFTP server box; if 
appropriate, change the default of Port 21; specify any User Name and Password 
required to login to the SFTP server in the User Name and Password boxes, the 
type of file to route to the SFTP server in the File Type box, the specific directory 
on the SFTP server in which to deposit the file in the Directory box (otherwise, it 
is deposited in the root), and check/uncheck the Banner box according to 
whether to create a banner page. 

Note:  When selecting Searchable PDF as the received fax file type, refer to the 
“OCR Option System Requirement Guidelines” section later in this chapter for  
information on the CPU power needed to perform OCR of received faxes. 

6. Click OK. 
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Configure Options and the Number of Fax Ports 
Follow this procedure to configure the installation of optional software (if the option 
was not installed/configured at Biscom).  When you enable a particular feature, you 
are prompted for its authorization code if the feature is a separate option. 

1. Click the Configure toolbar button , and select the Options tab (Figure 4-
17).  (You can also select Configure…Options or Configure…All 
Settings…Options.) 

 

Figure 4-17.  Options Tab 

2. If appropriate, click the OCR Option checkbox, and, when prompted, enter the 
authorization code communicated to you by Biscom to enable the option. 

Notes:  Once an option has been enabled, you can disable it and then reenable it 
without having to reenter an authorization code. 
If enabling the OCR option, refer to the following section for OCR system 
requirement guidelines.  

3. To increase the maximum number of fax ports that can be enabled on this fax 
server model (so long as your authorization code supports enabling that 
number), click the Maximum Fax Ports Change button.  You are prompted to 
enter an authorization code that supports enabling the higher number. 
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OCR Option System Requirement Guidelines 
You enable the OCR option in order to generate received faxes as searchable files.  
Since OCR is a CPU-intensive and time-consuming process, your system 
configuration – i.e., how many ports are receiving, how many ports are transmitting, 
how many transmit ports are translating from a native file format to TIFF – must be 
considered to conclude what CPU is needed.  A CPU of appropriate power is required 
to ensure that more faxes are not being received than the system can OCR. 

Internal performance testing has indicated that the typical server configuration of 
Dual Xeon 3.06Ghz, with 1 Gb RAM can support up to 48 receiving ports doing OCR 
and 24 transmit ports performing native file translation.  This performance testing 
transmitted typical two-page Word documents with dense text and a cover page, 
and represented not a peak load but rather a continuous, full load (i.e., all ports 
receiving one fax right after the other), with both transmit and receive ports 
configured for v.34 mode. 

The following table can be used as a guideline for estimating CPU requirements, 
where all configurations assume a dedicated FAXCOM Server and fax length of three 
or four pages. 

RX 
Ports 

TX 
Ports 

Mode TX Attachment Types System Configuration 

48 48 v.34 TIFF (no translation) Dual Xeon 3.06 Ghz, 1Gb 
RAM 

48 24 v.34 Mix of doc, xls, pdf,… Dual Xeon 3.06 Ghz, 1Gb 
RAM 

24 24 v.17 TIFF (no translation) Pentium 4 2.4 Ghz, 512 Mb 
RAM 

12 24 v.17 Mix of doc, xls, pdf,… Pentium 4 2.4 Ghz, 512 Mb 
RAM 

Configure Dialing Rules and Least Cost Routing 
Least Cost Routing (LCR) is an function that enables you to use your TCP/IP-based 
data network to route a fax to a remote FAXCOM Server, thereby minimizing the 
costs incurred when delivering faxes via long distance and international calls. 

It is NOT necessary to enable the full Least Cost Routing function in order to take 
advantage of two of its dialing rules features:  the capability to designate that 
certain phone numbers be delivered to internally by the fax server, rather than 
dialed out over the telephone network; the capability to specify multiple area codes 
for a server located where an Area Code Overlay Plan has been implemented.  For 
more information on using these features – even if Least Cost Routing has not been 
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enabled on the Options tab (Figure 4-16) – refer to the “Configuring Internal Phone 
Numbers,” “Configuring Dialing” and “Configuring Local Exchanges” sections later in 
this chapter 

Least Cost Routing Overview 
Least Cost Routing (LCR) is a function that enables you to use your TCP/IP-based 
data network to route a fax to a remote FAXCOM Server, thereby minimizing the 
costs incurred when delivering faxes via long distance and international calls.  Least 
Cost Routing – whereby the fax is converted to Group 3 or Group 4 format before 
being transmitted – occurs transparently and automatically once you have specified 
the necessary information. 

When a fax request is received by the FAXCOM Server, it parses the recipient phone 
number and classifies the call as either local, long distance, international or internal.  
Based on a set of rules you have previously defined, the server may determine that 
the fax should be routed to a remote fax server for delivery via the telephone 
network, or dialed internally from the server – without any call made over the 
telephone network.  (In fact, the flexibility of Least Cost Routing rules enables you to 
specify a back-up, secondary route over your data network to be used automatically 
in the event the primary route you have specified is unavailable.) 

When the fax call completes, confirmation is sent back via the data network to the 
originating FAXCOM Server, in order to return transmission status to the fax sender 
– who is unaware that the fax was re-routed via the data network. 

Figure 4-18 shows a basic implementation of Least Cost Routing. 
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Figure 4-18.  Basic Least Cost Routing Implementation 
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Least Cost Routing is integrated with the Alarm Management function to enable you  
to automatically monitor the Least Cost Routing links.  (Refer to the “Configuring 
Alarm Management Events” and “Configuring Alarm Notification Methods” sections 
earlier in this chapter for more information on the Alarm Management function.) 

Product Requirements 
Least Cost Routing has the following requirements: 

• At least two FAXCOM Servers in separate geographical locations 

• A TCP/IP-based network (public or private) with routing between all locations 
where the FAXCOM Servers are located 

• The TCP/IP option installed on each UNIX FAXCOM server in use; (TCP/IP is 
standard on the Windows FAXCOM Server) 

• Remote FAXCOM Server(s) must use TRAN host port mode 

• The Least Cost Routing program running on each FAXCOM Server 

• First 8 characters of the computer name of each FAXCOM Server must be unique 

Implement Least Cost Routing 
To implement Least Cost Routing, you perform the following tasks: 

• Configure the function 

• Enable the function  

Configure Least-Cost-Routing 
For Least-Cost-Routing to occur automatically and transparently, you specify 
information on the Dialing, Local Exchanges, Internal Numbers, LCR Routes and 
LCR Rules tabs for each participating server.  The Dialing information specifies the 
location of this server (i.e., the one on which you are running the Least Cost Routing 
configuration utility), and its associated area codes; the Local Exchanges 
information specifies the central office exchanges classified as local calls from this 
server, with the dialing format to use; the Internal Numbers information specifies 
those numbers that should be dialed internally by the server, rather than dialed 
externally over the telephone network; the LCR Routes information specifies the 
host IP address (or host name which maps to an IP address) and IP port of each 
remote server; the LCR Rules information specifies the matching pattern of digits 
that determines which route is used (and whether any alternate route is to be used 
automatically in the event the primary route you have specified is unavailable. 

You can do the configuration locally or remotely, via the modem and pcANYWHERE 
communications software shipped with the FAXCOM. 
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Note:  Since your FAXCOM server is shipped to you with only the pcANYWHERE 
Host PC component (i.e., server component), you would also have to purchase the 
pcANYWHERE Remote Control component (i.e., the client component) for a server 
that you wanted to configure remotely for Least Cost Routing.  You can purchase 
the Remote PC component either from Biscom or from Symantec.  

Configure Dialing 
An aspect of configuring the location of a server used in Least Cost Routing is 
specifying its associated area code(s).  A server can be associated with more than 
one area code because the demand for new telephone numbers has made it 
necessary to add new area codes for certain metropolitan regions of the United 
States and Canada (for example, in Massachusetts, Maryland and New York) by 
implementing an Area Code Overlay Plan.  With an Area Code Overlay Plan, a new 
area code is simply added to the same geographic region where an existing code 
already works.  That means that two area codes work in the same area (although 
only new phone lines and new telephone numbers will be given the new area code), 
without the need to change anyone’s telephone number.  For that reason, the Least 
Cost Routing option includes both the flexibility to specify multiple area codes for a 
server and support for both 7-digit and 10-digit (the Area Code + the 7-digit phone 
number) format dialing.   

Notes:  The Least Cost Routing function does not have to be enabled for you to 
associate your FAXCOM Server with more than one area code. 

Do the following to specify the location of this server: 

1. Click the Configure toolbar button , and select the Dialing tab (Figure 4-
19).  (You can also select Configure…Dialing or Configure…All 
Settings…Dialing.) 
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Figure 4-19.  Dialing Tab 

2. Fill out the Dialing tab as follows: 

Manually Overrride Country/Region – check this option if you live outside the 
US and want to and want to change any of the following fields on the Dialing 
tab: 

• Country Code 

• Long Distance Access Prefix 

• International Access Prefix 

Country Code – country code of this server’s location, for example, 1 for USA, 
44 for UK.  The country code is computed automatically from the locale for 
which you configured Windows.  If the displayed country code is incorrect, check 
the Manually Override Country/Region box and then enter the correct country 
code and access prefixes. 

Long Distance Access Prefix – long distance access prefix to be dialed by the 
server for long distance calls, for example, 1 in the USA.  This number is 
automatically assigned based on the locale for which you configured Windows.  
If the displayed country code is incorrect, check the Manually Override 
Country/Region box and then enter the correct international access prefix. 

International Access Prefix – international access prefix to be dialed by this 
server for international calls, for example 011 for USA.  This number is 
automatically assigned based on the locale for which you configured Windows. If 
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the displayed country code is incorrect, check the Manually Override 
Country/Region box and then enter the correct international access prefix. 

Area Code – enter the telephone area code of this server’s location; to specify 
multiple area codes if the server is in a region where an Area Code Overlay Plan 
has been implemented and local calls (not toll calls) can be made to an area 
code different from the server’s, do so on the Local Exchanges tab (Figure 4-19) 
– explained in the “Configure Local Exchanges” section immediately following.  If 
you need to configure the server so that it avoids dialing a long distance access 
prefix (such as 1), do so by selecting the Local Exchanges tab (Figure 4-19), and 
then configuring the appropriate Dial Format for the local exchanges for a 
specific area code. 

Dial Prefix – any digit you want the server always to dial before the fax number, 
such as a 9 to exit an office exchange; if the host application already prefixes 
the digit, do not enter the prefix value here, since it would cause the server to 
dial an extra digit and be unable to connect to the remote fax machine 

Check All Outbound Calls for Internal Delivery – check this box to specify that 
all outgoing fax calls be checked for whether they are found in the Dialing Rules 
and LCR Current Internal Phone Numbers table.  If you do not check this box, 
only those calls that arrive from a remote server to this server via Least Cost 
Routing are checked against the Current Internal Phone Numbers table. 

(Since it is necessarily time-consuming to check all outgoing numbers against 
the table, it is recommended that you do not check this box unless your site has 
a particular reason to route many calls internally [as, for example, when 
employees frequently fax material to themselves before faxing to a customer].) 

Note:  You can designate phone numbers as internal by entering them into the 
Dialing Rules and LCR Current Internal Phone Numbers table even though the 
Least Cost Routing function is not enabled at your site.  For more information on 
entering phone numbers into the Dialing Rules and LCR Current Internal Phone 
Numbers table, refer to the “Configuring Internal Numbers” section later in his 
chapter. 

Auto Insert Long Distance Access Prefix – check to specify that the server 
should automatically insert a 1 only if it detects the specified long distance fax 
number to be dialed contains only 10 digits.  If, for example, the fax sender 
entered 978-250-1800 as the destination fax number, the server would dial 1-
978-250-1800, enabling the call to go through correctly.  This capability applies 
only to servers in countries with Country Code 1 (i.e., US, Canada, some 
Caribbean countries). 
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Configure Local Exchanges 
On the Dialing tab (Figure 4-18), you specified an area code for the server.  Use the 
Local Exchanges tab (Figure 4-19) to configure local exchanges and dialing formats 
to use with the area code you specified on the Dialing tab. 

You can also use the Local Exchanges tab to define additional area codes (and their 
associated local exchanges and dialing formats) if, for example, you are located 
where an Area Code Overlay Plan has been implemented. 

Note: If necessary, refer to your telephone directory, or contact your telephone 
services provider, to obtain a list of the local exchanges used in your region. 
Do the following to specify the local exchanges and dialing formats associated with 
the area code you specified on the Dialing tab (Figure 4-18), and, if appropriate, 
define additional area codes and their local exchanges/dialing formats: 

1. Click the Configure toolbar button , and select the Local Exchanges tab 
(Figure 4-20).  (You can also select Configure…Local Exchanges or 
Configure…All Settings…Local Exchanges.) 

 

 

Figure 4-20.  Local Exchanges Tab 

2. Do either of the following: 
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• Select the area code you previously specified on the Dialing tab and click the 
Edit button to display the Local Exchanges dialog box for that area code 
(Figure 4-21). 

 

Figure 4-21.  Local Exchanges Dialog Box for Specified Area Code 

Or 

• Select an entry such as “Area Code Entry 2: Not Defined” and click the Edit 
button to display the Local Exchanges – Define new Area Code dialog box 
(Figure 4-22).  Specify an area code in the Area code box. 



74 

 

Figure 4-22.  Local Exchanges – Define New Area Code Dialog Box 

3. To insert a new exchange, click the Insert button.  A Local Exchange dialog box 
is displayed (Figure 4-23). 

 

Figure 4-23.  Configure Local Exchange Dialog  

4. In the Local Exchange box, specify a central office exchange within that 
particular area code) classified as a local call from this location.  When specifying 
multiple exchanges, you can use the X wildcard character, as, for example, 25X, 
XXX, etc.     

5. In the Use Dial Format list box, select the appropriate dialing format from the 
two dialing formats available.  Click OK. 
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6. Repeat steps 4 and 5 to add as many local exchange entries as is appropriate. 

7. To modify/delete a previously-specified local exchange, select the entry (on the 
Local Exchanges dialog box) and click Edit/Delete as appropriate. 

Configure LCR Routes 
Do the following to define remote routes (up to a maximum of 30) to other servers 
by specifying the Host IP address/Host Name and IP port of each remote FAXCOM 
fax server: 

1. Click the Configure toolbar button , and select the LCR Routes tab (Figure 
4-24).  (You can also select Configure…LCR Routes or Configure…All 
Settings…LCR Routes.) 

 

 Figure 4-24.  LCR Routes Tab 

2. Select the route for which you want to specify information, and click the 
Configure button to display the LCR Route dialog (Figure 4-25). 
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Figure 4-25.  LCR Route Dialog 

Note:  You can enter either an IP address or a host name – the first 8 characters of 
which must be unique for each FAXCOM server – into the Configure Route dialog 
box Host IP Address/Host Name field.  If you enter a name, however, you must 
have previously entered that name into either the local Host table 
(…\WINNT\system32\drivers\etc\host), or DNS and mapped the host name to 
an IP Address. The fax server program then does a look-up in either the local host 
table or DNS to determine the IP address to which that host name is mapped.  (The 
advantage to being able to specify a host name, rather than the IP address, is that 
you can change the IP address of the host without having to respecify the entry in 
the Configure Route dialog box Host IP Address/Host Name field.)  If you enter an 
IP Address, it is not necessary to have an entry in the Host table or DNS.   

3. Specify the host IP address (in dot notation, for example, 128.1.1.4), or the host 
name (in the exact format in which you entered it into the Host table or DNS) in 
the Host IP Address/Host Name box, the host IP port in the Host IP Port box 
and a brief description (such as “Server in New York”), for a specific route and 
press OK to save the information.  Be aware that you cannot leave this field 
blank. 

4. If appropriate, repeat the process of specifying the Route information for 
additional routes. 

5. Once you have specified the information for each route to be configured and are 
returned to the LCR Routes tab (Figure 4-24), select either Enable (for a Disabled 
route) or Disable (for an Enabled route), as is appropriate for each route.   

Depending on your choice, the route is either enabled or disabled. 

You are now ready to establish the Rules that pertain to a given route. 
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Configure Rules 
Do the following to configure the rules used to dynamically select a given route 
based on telephone number: 

1. Click the Configure toolbar button , and select the LCR Rules tab (Figure 4-
26).  (You can also select Configure…LCR Rules or Configure…All Settings…LCR 
Rules.) 

 

Figure 4-26.  LCR Rules Tab 

2. Either select a current rule entry and click the Edit button, or click the Insert 
button to add a new entry above the current cursor position.  (Bear in mind that 
the order of entries is crucial since the rules are selected according to the first 
match found in the list.  Therefore, if appropriate, you can always highlight an 
entry on the list and click either the Up or Down button to move it.)  The LCR 
Rule dialog is displayed (Figure 4-27). 
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Figure 4-27.  LCR Rule Dialog 

3. Specify the appropriate information as follows: 

Access Prefix – select either Long Distance or International as the access prefix 
to be dialed  

Match Digits – area code (for Long Distance) or country code (for International) 
to be associated with a specified route 

Note:  when specifying the area code/country code digits, you can use the X 
character (either upper or lower case) as a wildcard. 

You can also enter a Match Digits string to specify a rule for a particular region 
or city within the same country code (enabling you to select different routes to 
the same country code).   

An example of a Rule entry is 7A08, where 

7 is the Country Code 

A is the delimiter that specifies the end of the Country Code, and 

08 is the specific region within that Country Code for which this rule is being 
created 

Use LCR Route – is a required value that specifies the primary (first-choice) 
route to be associated with the specified area code/country code; (route 0 is 
used to specify the local server) 
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Alternate Route – is an optional value that specifies the secondary (second-
choice) route to automatically be used in the event the primary route (specified 
in the Use Route field) is unavailable 

Rule Description – label that identifies the rule being configured 

Use the local.lst File 

If it is more efficient, you can enter the local exchanges associated with an area 
code directly into a text file, rather than use the Least Cost Routing user interface.  
In major metropolitan areas, with millions of phone subscribers, there can easily be 
many local exchanges (since each local exchange services about 10,000 phone 
numbers). 

The text files for local exchanges are located in the u\ims\server directory, with 
the following naming convention:  local.lst for area code #1, local2.lst for 
area code 2, local3.lst for area code 3, local4.lst for area code 4,etc. 

The format of an local exchange text file is as follows: 
R. 1.0    <LF> 
250   0  <LF>  
272  1  <LF> 
256  0  <LF> 

where the first line is the revision number, followed by a line feed 

each local exchange entry is on a separate line, separated by a space or tab from the 
dialing format parameter to be used (either 0 or 1), followed by a line feed 

and the dialing format parameters are 

0 to specify dial 7 digits (XXX-XXXX)  

1 to specify dial 10 digits (XXX-XXX-XXXX) 

Configure Internal Numbers 
You can enter certain phone numbers into the Internal Numbers table that will be  
delivered internally by the server, rather than being dialed out over the telephone 
network.  

On the Dialing tab (Figure 4-19, you can choose whether all outbound calls are 
checked to determine if the number to dial has been entered into the Internal Phone 
Number table – or just calls routed through Least Cost Routing.    

Do the following to specify numbers that are to be delivered internally by the server, 
rather than being dialed over the telephone network: 

1. Select the Internal Phone Numbers tab (Figure 4-28), displaying any currently-
configured internal phone numbers. 
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Figure 4-28.  Internal Numbers Tab 

2. Either select a current internal phone number entry (by using the Up and Down 
buttons) and click the Edit button, or click the Insert button to add a new entry 
above the current cursor position.  The Internal Numbers Entry dialog is 
displayed (Figure 4-29). 

 

Figure 4-29.  Internal Numbers Entry 
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3. Enter values as follows: 

Number from (required field) – specify either the first of a range of fax numbers, 
or a single fax number 

Number to (optional field) – if specifying a range of numbers, enter the last 
number in the series 

Is assigned Fax Port Number (required field) – specify the fax port to be used for 
routing the specified number(s); if not using fax port routing, leave the default 
entry of 01. 

and Extension from (optional field) – if using DTMF, DID or PBX TIE Line routing, 
specify the first of a range of extensions, or a single extension  

and Extension to (optional field) -- if specifying a range of extensions, enter the 
last extension in the series 

Note: Since the Least Cost Routing table of internal numbers correlates with the 
Inbound Routing table, make sure that you have configured a Destination Type 
entry for the specified Line Number or specified Extensions through the Inbound 
Routing utility.  If necessary, refer to the Configuring Inbound Routing section for 
more information.    

Click OK. 

4. To remove a currently-configured entry from the Internal Phone Numbers table, 
use the Up and Down buttons to select the entry on the Internal Numbers tab 
(Figure 4-27), and click the Delete button.  

Understand Least Cost Routing Logs 
The following logs contain Least Cost Routing information: 

\u\ims\lcr.log – Least Cost Routing transmissions 

\u\ims\lcrerr.log – Least Cost Routing transmission errors, whereby there was 
an error when attempting to reroute the call via the network 

\u\ims\server\lcrlstats – Lifetime Least Cost Routing statistics 

\u\ims\server\lcristats – Interval time Least Cost Routing statistics 

\u\ims\server\lcrxxlstats – Per route lifetime statistics (where xx is the route 
number) 

\u\ims\server\lcrxxistats – Per route interval statistics (where xx is the route 
number) 

The following completion status codes apply to Least Cost Routing: 

0200 Least Cost Routing option not installed 
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0201 Least Cost Routing option disabled 

0202 Bad Least Cost Routing address specified, i.e., IP address 

0203 Unable to contact remote site 

0204 Lost contact with remote site 

0205 Least Cost Routing agent error preparing job 

0206 Least Cost Routing agent unable to extract destination country code 
from phone number  

Configure a Translation Server 
The Translation Server automatically translates native file fax attachments to the 
TIFF format suitable for faxing.  The native file types currently supported by the 
Translation Server are: 

• MS Word 

• MS Excel 

• MS PowerPoint 

• MS Project 

• MS Publisher 

• MS Access Snapshot files 

• Lotus 1-2-3 

• Lotus FreeLance 

• Lotus WordPro 

• WordPerfect 

• Visio 

• Adobe Acrobat 

• HTML documents 

There are four Translation Server options: 

Internal – a program running internally on the FAXCOM server 

External – the FAXCOM NT Translation Server (which has been superseded by the 
Internal option) 

ConServR – the file converter program from Lincoln & Co 

Xpdf – an open-source PDF viewer   
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This chapter describes the configuration and implementation of the Internal 
Translation Server.  

How the Translation Server is Shipped in a FAXCOM Server Pre-
built at Biscom 
When you receive FAXCOM Server with the internal Translation Server already 
installed, the Microsoft Office suite (MS Word, MS Excel, MS PowerPoint) is already 
installed for you so that you can translate those documents.  In addition, Internet 
Explorer is already installed, which enables you to translate Web page HTML 
documents.  If you then want to translate any of the additional supported 
applications (MS Project, the Lotus suite, WordPerfect, Visio, Adobe Acrobat), you 
must install those applications yourself. 

How to Install Translation Server Applications in a Customer-Built 
FAXCOM Server 
Refer to Appendix F for instructions for installing Adobe Acrobat and the MS Office 
suite (MS Word/Excel/PowerPoint) according to Translation Server requirements.   
Appendix F also lists special considerations for successfully using the Translation 
Server. 

Configure the Internal Translation Server 
You configure your internal Translation Server by specifying the document 
extensions used with your native files. 

You can also use the Alarm Management function to monitor the Translation Server 
for errors.  (Refer to the “Configuring the Alarm Management Function” section 
earlier in this chapter for more information about the Alarm Management function.)   

Do the following to configure an internal Translation Server: 

1. Click the Configure toolbar button , and select the Translation Server tab 
(Figure 4-30).  (You can also select Configure…Translation Server or 
Configure…All Settings…Translation Server.) 
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Figure 4-30.  Translation Server Tab 

2. In the Translation Server Type box, check the Internal button. 

3. In the Intermediate Format box, accept the default of PCL (unless advised to do 
otherwise by Biscom Technical Support). 

4. In the Timeout box, specify the maximum time in minutes allotted to the 
Translation Server to convert a document, after which time the Translation 
Server will send a timeout message to the FAXCOM Server application; the 
FAXCOM then responds by issuing a command to the Translation Server to 
terminate the application; the default is five minutes. 

5. Use Xpdf for PDF rendering – select this checkbox in order to use the embedded 
PDF viewer to render PDF documents, rather than having to install Adobe 
Acrobat. 

6. Click the Document Extensions… button to display the Document Extensions 
table (Figure 4-31), listing the current document extensions for all the 
currently-supported applications. 

Note that while the supported applications are listed for you, only the three 
Microsoft Office applications (MS Word, MS Excel and PowerPoint) and Internet 
Explorer, which were installed for you at Biscom) default to Enabled, while the 
others (which you must install yourself) default to Disabled. 
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Figure 4-31.  Document Extensions Table 

7. Be aware of the following consideration before using any of the functions in the 
table: 

• For you to successfully translate the native documents of an application, that 
application must fulfill two requirements:  it must be an application currently 
supported by the Translation Server, and it must be an application that is 
currently installed (so that the extension(s) associated with the application 
were automatically added to the registry when the application was installed 
on the computer where the Translation Server program is running).  In other 
words, you cannot successfully translate either the native files of an 
application Biscom does not currently support (for example, CorelDRAW), or 
the native files of a supported application that is not installed (for example 
Visio) – and you may receive the following error message when attempting to 
configure the applications (Figure 4-32). 

 

Figure 4-32.  Unregistered Application Error Message 
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Note:  It is possible you may not receive this error message for an installed, 
unsupported application (since it is registered), and the translation of the files 
created by this unsupported application may or may not be successful.  

8. If appropriate, do any of the following in the Document Extensions table (Figure 
4-30) – where the list order of the table is irrelevant: 

• Click the Enable button to enable a disabled entry 

• Click the Disable button to disable an enabled entry 

• Click the Delete button to delete an entry 

• Click the Insert button to display the Document Extension Entry dialog 
(Figure 4-31) to add an entry (only for an additional supported application); 
enter the document extensions, separated only by commas (no spaces or 
periods), and enter a description of the application for your own reference. 

• Click the Edit button to display the Document Extension Entry dialog (Figure 
4-33) to modify an entry. 

 

Figure 4-33.  Document Extension Entry Dialog 

To insert/edit an entry in the Document Extension dialog box, specify the 
document extension(s) associated with the application (as listed in the 
registry) in the Document Extensions box; enter the document extensions, 
separated only by commas (no spaces or periods), and enter a description of 
the application for your own reference. 

Click the OK button to save your changes (which take effect immediately). 

Configure Data Archive 
The FAXCOM Server Administrator program includes the capability to store copies of 
fax jobs.  You configure what fax jobs to archive according to Job Type and Result 
Type, and you have the following archiving choices: 

• Successfully transmitted faxes 
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• Successfully received faxes 

• Successfully transmitted and received faxes 

• Successfully and partially transmitted faxes 

• Successfully and partially received faxes 

• Successfully and partially transmitted and received faxes 

You can archive fax jobs sent and received by any local fax port, including jobs that 
were Least Cost Routed via a remote fax server, as well as jobs that were internally 
delivered.  The main archive directory is u\ims\archive, which includes the 
function’s log files and operating files.  The archived data itself is stored in the 
u\ims\archive\data subdirectory.  The files are stored as multipage TIFF Group 3 
images, with the naming format of qXXXXXXXX.tif, where XXXXXXXX  is an 
incrementing number starting at 00000000.  For example, the first job archived 
would be assigned the name q00000000.tif, the second q00000001.tif, etc. 

Do the following to configure Data Archive: 

1. Click the Configure toolbar button , and select the Data Archive tab (Figure 
4-34).  (You can also select Configure…Data Archive or Configure…All 
Settings…Data Archive.) 

 

Figure 4-34.  Data Archive Tab 
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2. Fill in the following fields: 

Archive Control – check Enable to activate the function; check Disable to specify 
no fax copies be made and stored    

Archive Status – whether or not the data archive function is running 

Archive Data Job Type – select TX/RX to store both transmitted and received 
jobs; TX Only to store only transmitted jobs; RX Only to store only received jobs 

Archive Data Result Type – select OK Only to store only successful jobs; OK and 
Partial to store both successful jobs and partially successful jobs (i.e., at least 
one page delivered/received); fax jobs that return a transmitted/received page 
count of zero are not archived. 

Auto Clean Up Configuration 
Method – select None if the archived data directory is not to be cleaned up by 
any automatic method; select Size to specify archived data should be cleaned up 
once the directory exceeds the value specified in the Max. Size field; select Age 
to specify archived data should be cleaned up once the age limit specified in the 
Max. Age box is exceeded; select Move to specify archived data should be 
migrated to the UNC path specified in the UNC Path field 

Max. Size – (enabled only if you selected Size for the Auto Clean Up Method), 
specify the maximum size in MB the data in the archival directory can occupy 
before the cleanup agent starts to delete the oldest files from the directory – 
with the following consideration: 

Note:  be aware that since the cleanup agent runs every 15 minutes, it is possible 
for more than the specified Max. size to accumulate before the cycle runs.  For 
example, if you have a 24-line system and (worse-case) 2 MB of data accumulates 
for each line in 15 minutes, potentially an extra 50 MB of data could accumulate 
(for a total of 100 MB) before the directory is trimmed back to 50 MB. 

Max. Age – (enabled only if you selected Age for the Auto Clean Up Method), 
specify the age limit in hours before archived data is deleted from the directory 

UNC Path – (enabled only if you selected Move for the Auto Clean Up Method), 
specify the UNC path to a remote file share where data is migrated every 15 
minutes when the cleanup agent runs.  Be aware that since the FAXCOM Server is 
running as a Windows 2000 service using system account privileges, to have 
access privileges to the remote share, you will probably need to configure the 
Log On As Account for the FAXCOM service and set it to an Administrator 
account (i.e., a member of the Administrator group) that has access privileges to 
the remote file share and requires a password.  (You configure the Log On As 
Account by selecting Start…Settings…Control Panel…Services.  Select the 
Faxcom service and click the Startup button.) 

Archive Logs Cleanup  
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Delete all but the latest logs – check to specify that all but the last two Archive 
Activity logs be automatically overwritten each time they reach the maximum 
size of 500 KB and renamed to arcold.log.  

Never delete logs – check to specify that each time the Archive Activity log 
reaches its maximum size of 500 KB, it be renamed to arcXXXXXXXX.log, where 
XXXXXXXX is an 8-digit incrementing number starting at 00000001.    Make sure 
you check this check box only if you are using another, external application to 
automatically purge these files; otherwise, these files could eventually fill up the 
disk. 

Delete logs when data is deleted – check to specify that when the archive clean 
up deletes the data files for the old faxes, the log files for that time period are 
also deleted; in other words, the number of log files kept is determined by the 
number of actual faxes kept in the archive. 

Click OK.  Be aware that the new archive configuration changes will not take 
effect until the next time the Fax Server application is restarted. 

Archive Log Sample 
The following is an excerpt (with 3 entries) from an archive log (u:\ims\data\arc.log): 
Archived: \u\ims\archive\data\q00009800.tif --> tx ok  via internal on 02/05/1999 
01:26:36, Fax Line: 01, To: Jim Harrison, Phone Number: 40, Company: , Subject: hello 
, Status Code: 0000[ ok ], 001 Pages, in 0000 secs, Baud Rate: 14400 , Resolution: L, 
Remote Fax ID: SMTP FAX 1          , Job ID: 9454, User Id: 
<bagudelo@test.biscominc.com>, User Name: Bill Agudelo Account  

Archived: \u\ims\archive\data\q00009801.tif --> rx ok  via internal on 02/05/1999 
01:26:36, Fax Line: 01, Status Code 0000[ ok ], 001 Pages, in 0000 secs, Baud Rate: 
14400 , Resolution: L, Remote Fax ID: , DID/DTMF Digits:   

Archived: \u\ims\archive\data\q00009802.tif --> tx ok  via internal on 02/05/1999 
01:41:33, Fax Line: 01, To: Jim Harrison, Phone Number: 40, Company: , Subject: test 
, Status Code: 0000[ ok ], 001 Pages, in 0000 secs, Baud Rate: 14400 , Resolution: L, 
Remote Fax ID: SMTP FAX 1          , Job ID: 9455, User Id: 
<bagudelo@test.biscominc.com>, User Name: Bill Agudelo Account 

Configure SMTP Integration 
The FAXCOM Server integrates with TCP/IP-based Simple Mail Transfer Protocol 
(SMTP) networks in the following ways: 

• Alarm notifications sent as SMTP mail messages to a remote SMTP mailbox 

• Support for Mailsend, a FAXCOM Command Language (FCL) command – primarily 
used by third-party integrators – that tells the FAXCOM Server to e-mail a job to 
an SMTP mail recipient (instead of faxing it to a fax number) 

• Support for inbound routing of incoming faxes to an SMTP mailbox 
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• Support for the SMTP Gateway included in FAXCOM Suite for Windows, which 
works with the Microsoft SMTP service to enable network users to transmit 
(ONLY) MIME-encoded e-mail messages to remote fax machines. 
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Chapter Five:  Manage and Monitor the FAXCOM Server  

Overview 
Once you have configured your server, you perform the following basic tasks 
through the FAXCOM Server Administrator program to manage your FAXCOM server: 

• Backup the appropriate directories 

• Control the FAXCOM service (by starting/stopping/pausing the service) 

• Manage Fax ports 

• Simulate an alarm 

• Clear an alarm 

• Monitor the Translation Server 

• Locate Form and Signature Files 

• View and search through log files 

• Save the desktop 

• Save/send/restore configuration and log files 

• Provide remote access to Biscom support personnel 

• Use Netstat to troubleshoot networking TCP/IP problems 

• Verify the TCP stack is operational 

• View status for the following: 

Alarms 
Fax Ports 
Host Ports 
Installed Options 
Job Statistics 
Tasks 
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Note:  Make sure that you always shut down your FAXCOM Server by following the 
proper shutdown procedure:  click the Start button, click Shut Down, and then 
click Shut Down The Computer.  DO NOT turn off your computer until the “You can 
now safely turn off your computer” message appears. 
You can also log off your FAXCOM Server so someone else can use it by doing the 
following:  click the Start button, click Shut Down, and then click Close All 
Programs And Log On As A Different User.   

Backup the Appropriate Directories 
The following lists the directories you should backup on the FAXCOM Server: 

Configuration Files 
 \Program Files\Biscom\FAXCOM Server\u\FAPI\Cfg 

 \Program Files\Biscom\FAXCOM Server\u\ims\server 

 \Program Files\Biscom\FAXCOM Server\u\ims\fax 

 \Program Files\Biscom\FAXCOM Server\u\ims\home 

 \Program Files\Biscom\FAXCOM Server\u\ims\host 

 \Program Files\Biscom\FAXCOM Server\u\ims\sessions 

 \Program Files\Biscom\FAXCOM Server\u\ims\smtp 

 \Program Files\Biscom\FAXCOM Server\saveCfg\u\mdqs\qconf (file) 

Log files 
 \Program Files\Biscom\FAXCOM Server\saveLog\u\FAPI\Log 

 \Program Files\Biscom\FAXCOM Server\saveLog\u\ims 

 \Program Files\Biscom\FAXCOM Server\saveLog\u\usr\tmp 

 \Program Files\Biscom\FAXCOM Server\u\ims\archive 

Control the FAXCOM Service 
Controlling the FAXCOM service consists of starting, stopping and pausing the 
service, as follows: 

Start the Service 
You can start the FAXCOM Server service via any of the following ways: 
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1. Click the Start Service button   in the toolbar. You will see FAXCOM Service 
running in the lower left corner of the window 

or 

2. Click the Action menu and select Control FAXCOM Service…Start or Resume 
Service 

or 

3. In the command-line interface (Start…Programs…Accessories…Command 
Prompt), enter net start faxcom. 

Stop the Service 
Stopping the FAXCOM Server service interrupts all fax calls in progress - both 
receiving and transmitting.  Inbound faxes in progress will stop with a failure 
message sent to the sender.  The queue will indicate which outbound messages in 
progress were successfully or partially transmitted; the outbound faxes will continue 
transmission once the service is re-started. 

Biscom recommends that if you must stop the service while there is fax port activity, 
you should first pause the service.  You can view current fax port activity on the Fax 
Ports window. 

You can stop the service via any of the following ways: 

1. Click the Stop Service button   in the toolbar 

or 

2. Click the Action menu and select Control FAXCOM Service…Stop Service 

or 

3. In the command-line interface (Start…Programs…Accessories…Command 
Prompt), enter net stop faxcom. 

Pause the Service 
When the service is paused, the server allows fax ports to complete transmissions or 
receptions which are in progress, but no new jobs will be processed.  When the in-
progress jobs are completed, the service is in a state of "limbo" until you indicate 
whether to stop or start the service.  Note that pausing the service does not prevent 
the sending of e-mail messages from the server.  You can pause the service via any 
of the following ways: 

1. Click the Pause Service button   in the toolbar 
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or 

2. Click the Action menu and select Control FAXCOM Service…Pause Service. 

Pausing the service initiates an action that takes 6 seconds, during which the 
mouse pointer displays as an hourglass   icon.  Operation of the user interface 
is suspended during a 6-second interval, during which time you cannot enter 
any input. 

Manage Fax Ports 
Do the following to manage fax ports, which consists of Starting, Stopping and 
Configuring the port: 

• Click the Configure toolbar button , and select the Fax Ports tab.  (You can 
also select Configure…Ports…Fax Ports or Configure…All Settings…Fax Ports.) 

To start the port, highlight the port and click the Start button. 

To stop the port, highlight the port and click the Stop button. 

To configure the port, highlight the port and click the Configure button to 
display the Configure Fax Port dialog box. 

Follow the instructions in the “Configuring Fax Ports” section in Chapter 4. 

Manage Host Ports 
Do the following to manage host ports, which consists of Starting, Stopping and 
Configuring the port: 

• Click the Configure toolbar button , and select the Host Ports tab.  (You 
can also select Configure…Ports…Host Ports or Configure…All Settings…Host 
Ports.) 

To start the port, highlight the port and click the Start button. 

To stop the port, highlight the port and click the Stop button. 

To configure the port, highlight the port and click the Configure button to 
display the Configure Host Port dialog box. 

Follow the instructions in the “Configuring Host Ports” section in Chapter 4. 
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Simulate an Alarm 
Do the following to simulate an alarm for testing purposes (if the option is 
configured according to the procedures in the “Configuring Alarm Management 
Events” and “Configuring Alarm Notification Methods” sections in Chapter 4): 

1. Select Alarms from the Action pull-down menu. 

2. Select Simulate Alarm. 

You may view the alarm on the Current Alarms window before clearing the alarm 
(by selecting View…Alarms). 

Clear an Alarm 
To clear an alarm that has triggered, do the following: 

1. Select Alarms from the Action pull-down menu. 

2. Select Clear Alarm, or click the Clear Alarm button  in the toolbar. 

Monitor the Translation Server 

With the Alarm Management Function: 
If your site is using both Translation Server and the Alarm Management functions, 
you can specify that an alarm be generated in the event of Translation Server errors.  
These errors can be of two kinds:  connection errors between the FAXCOM and the 
Translation Server (only when using an external Translation Server) and translation 
errors, whereby the Translation Server is not able successfully to translate a job. 

The information displayed for a translation error is particularly helpful for the 
following reason: 

In the event of an error converting any single attachment (if there are multiple 
attachments), the entire fax job is declared unsuccessful.   Moreover, the message 
returned to the originator of the failed outgoing fax does not indicate the specific 
attachment that failed  That information is, however, available to the fax server 
administrator, who can then inform the fax originator of precisely which attachment 
had the problem (and perhaps advise him/her to resubmit the job without the 
attachment that caused the problem). 

To view more information for the alarm, click  to display the Alarm log.  
Translation Server errors are shown as Alarm 40. 
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(You can also click  and select the Alarm Log itself to see alarm information 
that is not limited to the last 5 alarms, and that is not flushed every time the system 
is rebooted.) 

Without the Alarm Management Function: 
If your site is using Translation Server without also enabling the Alarm Management 
function, you will not automatically be notified in the event of a Translation Server 
error, but you can still display information for the Translation Server by selecting 
View…Log…Launch Event Viewer.  The Event Viewer Applications log includes 
information for all alarms, and an entry for each time the fax service is 
started/stopped. 

To display the details of a specific event, double-click the event to display the Event 
Detail window. 

Manage Images 
You can merge images stored on the FAXCOM with outgoing faxes by issuing a 
FAXCOM Command Language (FCL) command to invoke the image. 

Be aware of the following considerations for these images: 

• Images consist of named two-dimensional 1-bit per pixel digital images 
designed to be printed at 200 dpi 

• Image size must not exceed 1728 dots per row and 2233 rows 

• Image names consist of from 1 to 63 alphanumeric characters 

• Each image is stored in a file using either PCX/DCX format or one of the 
following TIFF formats 

- Uncompressed 

- Packed Bits 

- Group 3 1D 

- Group 4 with no uncompressed lines 

- LZW-encoded 

• Files containing the images are stored in the \ims\home directory 

• File names of the files containing the image conform to one of two naming 
conventions, depending on the FCL command used to invoke the image, either: 

- FORMx.FAX, where x is the name of the image and the image is to be 
invoked by the $FORM$ FCL command 
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- SIGNx.FAX, where x is the name of the image and the image is to be invoked 
by the $SIG$ FCL command 

View and Search Through Log Files 
You can view various log files, including ones you have previously stored, and use 
the Filter and Find functions, as follows: 

Choose a Log File to Open 
Do the following to open a log: 

1. Select Log from the View pull-down menu to display a list of the logs you can 
view (Figure 5-1). 

 

Figure 5-1.  View Log Menu 

You can also click the View Logs button  to choose a  log (Figure 5-2). 



98 

  

Figure 5-2.  Choose Log File 

2. Choose either a specific log, or browse your file listing for a log you previously 
saved as a text file. 

Filter a Log  
You can filter any of the logs to display search criterion you enter.  The filtered 
information is displayed in a new window, and you can switch back and forth 
between your original log window and the filtered information window.  You can 
also execute the filter function again to further refine your search. 

Do the following to filter a log: 

1. With a log displayed, select Filter from the Edit pull-down menu to display the 
Filter Log View dialog (Figure 5-3). 

 

Figure 5-3.  Filter Log View Dialog 

2. In the Find all lines containing box, enter the filter criterion text with which to 
search the log.  The FAXCOM Server program matches patterns that conform to 
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a standard regular expression as used in UNIX.  If appropriate, check any of the 
following: 

Match Case – whereby the filter view distinguishes between uppercase and 
lowercase characters.  When you check Match case, the filter view finds only 
those instances in which the capitalization matches the text you typed in the 
Find all lines containing box 

Inverse Filter –  whereby the filter view displays all lines NOT containing the 
string you type in the Find all lines containing box 

Regular Expression – whereby the filter view matches patterns of text that 
consist of ordinary characters, as, for e.g., letters a through z, and special 
characters, known as metacharacters, as, for e.g., ^, \, [.  The regular expression 
serves as a template for matching a character pattern to a string being searched. 

The filtered information is displayed in a new window, with each matching 
instance of the filter criterion on its own line. 

3. If desired, click the Print toolbar button to print either the filtered log or the log 
itself. 

Use the Find Function in a Log 
You can search any log for a specific search string, as follows: 

1. With a log displayed, select Find from the Edit pull-down menu to display the 
Find dialog (Figure 5-4). 

 

 Figure 5-4.  Find Dialog 

2. In the Find What box, enter the string for which you want to search. 

To distinguish between upper and lowercase characters, select the Match 
case check box. 

To specify the search direction, click either the Up or Down button. 

Once the first instance of the specified string has been located, click the Find 
Next button to find and select the next occurrence of the text. 
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Launch the Event Viewer 
You can launch the Event Viewer from within the FAXCOM Server Administrator 
program.  The Event Viewer records FAXCOM Server processing events, which 
includes information for all alarms, and an entry for each time the service is 
started/stopped. 

Do the following to launch the Event Viewer: 

1. Select Log from the View pull-down menu to display a list of the logs you can 
view. 

2. Select Launch Event Viewer to go directly to the Event Viewer application (Figure 
5-5). 

 

Figure 5-5.  Event Viewer 

3. Double-click the event to display its details (Figure 5-6). 

 

Figure 5-6.  Event Details 
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If you have installed the Translation Server option, Translation Server 
connection and file translation errors are displayed, and the information is 
particularly helpful for the following reason: 

In the event of an error translating any single attachment (if there are multiple 
attachments), the entire fax job is declared unsuccessful.  Moreover, the 
message returned to the originator of the failed outgoing fax does not indicate 
the specific attachment that failed.  That information is available through the 
Event Viewer to the FAXCOM Server administrator, who can then inform the fax 
originator of precisely which attachment had the problem (and perhaps advise 
him/her to resubmit the job without the attachment that caused the problem). 

Launch Performance Monitor 
You can invoke the Performance tool directly from the FAXCOM Server Administrator 
program, as well as from Control Panel…Administrative Tools – with the following 
difference. 

When you invoke the Performance tool by clicking the Performance Monitor button 
on the Job Statistics window, the Performance Monitor launches and displays with 
the FAXCOM Fax Server-specific view.  The FAXCOM Fax Server performance object 
installs with 6 counters: 

• Rx Active Ports 

• Rx Pages/Hour 

• Total Active Ports 

• Total Pages/Hour 

• Tx Active Ports 

• Tx Pages/Hour 

The default counter is Total Pages/Hour.  

To view performance on the other counters, do the following:  

1. Click the Add button .  

2. Select FAXCOM Fax Server in the performance object list.  

3. Select all counters or select specific counters in the counter list.  

For more information on using the MMC system monitor snap-in, click the Help 
button    in the performance monitor window. 

When you launch Performance Monitor from the Windows Start menu 
(Start…Programs…Administrative Tools…Performance), you must specify which 
performance object to monitorand then follow steps 1-3 above.    
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1. To invoke the Performance tool from the Fax Server Administrator program, 

either click the View Job Statistics toolbar button , or select Job Statistics 
from the View pull-down menu to display the Job Statistics window. 

2. Click the Performance Monitor button. 

Save the Desktop 
To save the arrangement of windows on your desktop when running the FAXCOM 
Server Administrator program, check the Save Desktop option from the File menu.  
If a check is visible, the desktop will be saved "as is" upon closing FAXCOM Server  
Administrator.  If the check is not visible, the desktop will return to its default 
arrangement the next time it is opened. 

Save/Send Configuration and Log Files 
The FAXCOM Server Administrator program includes a function for saving 
configuration and/or log files – primarily so that you can later restore a previous 
configuration.  The function also includes the capability to e-mail the saved files 
(particularly helpful when working with the Biscom Technical Support department). 

Do the following to use the function: 

Save Files: 
1. Select Save Configuration… from the File menu to display the Save Files tab 

(Figure 5-7). 
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Figure 5-7.  Save Files Tab 

2. Select the appropriate radio button: 

Save Configuration and Log Files 

Save Log Files 

Save Configuration Files 

Notice that the radio button you select determines the file name as follows: 

Configuration and Log Files – cl.zip 

Log Files – log.zip 

Configuration Files – cfg.zip 

3. Click the Browse button to specify the folder in which to create the specified 
directory and file.  Click the Save button. 

Send Files: 
Do the following to send configuration and/or log files: 

1. Select Save Configuration… from the File menu; select the Send Files tab (Figure 
5-8). 
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Figure 5-8.  Send Files Tab 

2. Select the appropriate files to send, either: 

Configuration and Log Files 

Log Files  

Configuration Files 

Notice that the radio button you select determines the suggested e-mail memo 
that describes the enclosed files. 

3. If you wish, modify the pre-filled information in the Subject and Memo boxes; 
otherwise, keep the suggested information. 

4. In the From box, specify the sender’s e-mail address; in the To box, specify the 
recipient’s e-mail addess.  Click the Send button. 

Restore Configuration and/or Log Files 
When you choose to save configuration and/or log files, the files are saved into the 
specified directory location.  In addition, the files are compressed into a zip file so 
that you can easily transfer them – via e-mail or ftp – to a remote location. 

You restore configuration and/or log files by running the Windows Explorer 
program and doing a manual copy.  Because the Save Configuration utility preserves 
the FAXCOM Server directory structure, you can restore your entire configuration by 
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copying to the \u directory.  For example, if the FAXCOM Server is installed on the D 
drive, you would copy to D:\u. 

Note:  When restoring the files, be sure to exclude the following file (which will 
automatically be reproduced for you at system start-up):  Biscom\FAXCOM 
Server\u\ims\server\bistran.ini. 

Use netstat to Troubleshoot Networking TCP/IP Problems 
You can use the netstat utility to troubleshoot networking TCP/IP problems.  The 
utility displays currently active TCP connections, interface statistics and currently 
allocated buffers. 

• At the command prompt, type netstat /? to access help for using netstat to 
display active TCP/IP connection information. 

Verify the TCP Stack is Operational 
Before using the following utilities, make sure the FAXCOM server is connected to a 
live network.  If using the Token Ring interface, it is especially important that you 
make sure that the adapter cable is plugged into the FAXCOM before you apply 
power to the server. 

You can verify the operation of the TCP stack as follows: 

1. At the command prompt, type ping IP address (for example, 127.0.0.1). 

If the TCP stack is operational, messages such as the following are scrolled 
on the screen and continuously updated every few seconds: 

Reply from 127.0.0.1: bytes=32 time<10ms TTL=32 

If no messages appear, or do not get updated every few seconds, the TCP 
stack may not be operational. 

2. If the command in step 1 was successful, perform an additional test, as follows: 

• Type ping <FAXCOM server name> 

where FAXCOM server name is the name displayed when you do the following: 

• Select Start…Settings. 

• Select Control Panel…Network…FAXCOM. 

• Select the Identification tab to display the FAXCOM Computer Name 

If the TCP stack is operational, messages such as the following are scrolled on 
the screen and continuously updated every few seconds: 

Reply from 127.0.0.1: bytes=32 time<10ms TTL=32 
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If no messages appear, or do not get updated every few seconds, the TCP stack 
may not be operational. 

3. If the command in step 2 was successful, ping a known host IP address, 
preferably in the same segment. 

View Fax Server Status 
The Administrator program lets you view the following information: 

View Tasks 
If the Tasks window is not displayed in the FAXCOM Server Administrator program, 

click the View Tasks button   in the toolbar, or click the View menu and select 
Tasks. 

The Tasks window (Figure 5-9) displays the status of each task currently active in 
the FAXCOM server.  You can see a queued task summary, process task states, and 
job task states.  You can sort on any of the fields in the table, but keep in mind that 
the task list continually updates.   You will also see Completion Status Codes.  A 
completion status code is returned for each fax transmission.  Refer to Appendix A 
for a complete list of all completion status codes, with an explanation for each.  (All 
but one completion status code is an error message.) 

 

Figure 5-9.  View Currently-Running Tasks 

Queued Tasks Summaries: 

If there are any queued tasks, you will see a single summary line for each category 
of queued task (conversion tasks, fax delivery tasks, fax receiving tasks, message 
delivery tasks, and LCR delivery tasks).  No summary line displays if there are no 
queued tasks. 
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Process Tasks: 

In the Tasks window you will find information for process tasks: 

Fax ports task – this line item represents transmitting and receiving for all fax 
ports.  Includes the number of fax ports enabled for transmitting (tx) and the 
number of fax ports enabled for receiving (rx). 

Example:  FAX ports enabled (4tx, 4rx) 

Workflow task – this line item indicates that the workflow process is active. The 
workflow process is a single process that manages queued tasks, except for "FAX 
delivery queued."  Appears in Tasks window as:  FAXCOM workflow enabled 

Host ports task(s) – one line item represents each active host port; includes host 
port, mode, and socket number.  Examples include: 
FAXCOM service active via TCP:6000 

FAXCOM service active via TRAN:6001 

Host connections task(s) – a host connection line item indicates one of the 
following: 
FAXCOM connected, waiting for job 

FAXCOM connected, processing job 

FAXCOM submitting job  

Job Tasks  

Information on job tasks, displays in the Tasks window and then disappears when 
completed.  There are a number of possible status messages you may see for job 
tasks: 

Conversion tasks – when converting an outbound job to fax, print, or e-mail 
format, the status appears on the task list as one of the following: 
FAX conversion running 

FAX conversion done 

Fax delivery tasks – when transmitting a fax, the job task status appears as one 
of the following: 
FAX delivery running (preparing to dial) 

FAX delivery connecting (dialing or dialed and waiting for 
answer) 

FAX delivery connected (answered; preparing to transmit) 

FAX delivery transmitting 

FAX delivery awaiting retry 

FAX delivery done 
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Fax receiving tasks – when receiving a fax, the job task status appears as one of 
the following: 
FAX receiving active (including from whom and to whom) 

FAX inbound routing active 

FAX receiving done 

Message delivery tasks – when delivering or receiving a message, the job task 
status appears as one of the following:  
Message delivery active 

Message delivery awaiting retry 

Message delivery done 

LCR delivery tasks -- when an outbound fax job is forwarded to another fax 
server, the status appears as one of the following: 
LCR delivery contacting 

LCR delivery contacted 

LCR delivery transmitting 

LCR delivery awaiting retry 

LCR delivery done 

Tasks Update Speed 
Tasks, as they are viewed in the Tasks window (Figure 5-9)  or the FAXCOM Server 
Administrator main window, generally update every 3 seconds.  To change the 
speed at which the current tasks are updated, follow these steps: 

1. Click the View menu, and select Tasks Update Speed. 

2. Select one of the following options: 

High – tasks update every 1 second 

Normal – tasks update every 3 seconds  

Low – tasks update every 10 seconds 

Paused – tasks do not update until High, Normal, or Low is selected or until the  
window is closed and reopened 

The task update speed resets to Normal each time the FAXCOM Server Administrator 
program is restarted. 
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View Fax Ports 

Fax Ports – each fax port according to its current configuration and current 
state, as follows (Figure 5-10): 

 

Figure 5-10.  View Fax Ports Window 

Name – faxnn, where nn is the number of the fax line (fax01 – fax96) 

Mode – either Transit/Receive if both outbound and inbound traffic is handled; 
Transmit Only if only outbound traffic is allowed, with no incoming calls 
answered; Receive Only if only inbound fax traffic is to be handled, with no 
outbound fax jobs queued to this port; Disabled if the fax port has been 
manually set to neither receive nor transmit faxes. 

Status – refers to a fax port's current state.  Status designations include: 

Idle - port has been started and is not processing 

Stopped - port service was stopped 

Paused - port will not start a new job, but will finish transmitting or 
receiving any job currently active on the port 
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Transmitting - port is currently transmitting a fax 

Receiving - port is currently receiving a fax 

Not Installed - no hardware board is present 

Bad line - port has been disabled after two consecutive no-dial-tone errors 
occur if port has been configured for auto disable (see Configuring Fax 
Ports).  Typically seen when a phone line is disconnected. 

Down - an error that requires re-initialization has occurred. 

No response - initialization attempt has failed, and port cannot be used 

Transient status designations, which only occur very briefly, include:  

Starting - port service is starting up 

Stopping - service is stopping 

Initializing - port is initializing 

View Host Ports 

Host Ports – each Host Port according to its current configuration and 
current state, as follows (Figure 5-11): 

 

Figure 5-11.  View Host Ports Window 

Name – hostn, where n is the number of the host port 

Mode – Connection Mode, where TCP is communication over TCP/IP 
connections; TRAN is communication over TCP/IP using Sessions mode to 
enable multiple FAXCOM Queues to share the same host port; SMTP is 
communication over an SMTP port to a FAXCOM Queue that receives email 
messages to be delivered as faxes; COM is for communication to a single 
FAXCOM Queue, and is generally a much slower connection used in legacy 
environments, such as one without TCP/IP. 
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Status – either Stopped or Started. 

View Job Statistics 

Job Statistics – a display of server operation data which you can configure 
according to:  Calculation Method, Time Span and Job Type.  From the View Job 
Statistics window, you can also launch the Performance Monitor to view additional 
data.  Figure 5-12 shows the Job Statistics display. 

 

Figure 5-12.  View Job Statistics Window 

When you choose to view fax server Job Statistics, you can specify various 
parameters that determine how data is  displayed, as follows: 

Data Selection – either calculated cumulatively over the System Lifetime, or 
averaged hourly 

Time Span – either 
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• spanning the System Lifetime (from when the system was first installed at 
the factory) 

• since the counter was either manually reset by clicking the Reset Counter 
button, or automatically reset at reboot 

• for the last 60 minutes 

Job Type – either All (both Transmit and Receive), Transmit only, Receive only  

In this window, you can also click the Reset Counter button to reset the counter. 

Fax port data displays in the table at the bottom of the window. It includes 
information that does not display in the Fax Ports window. In the Job Statistics 
window, you can view the additional information: 

Attempts – number of attempted transmissions since last counter reset 

Pages – cumulative number of pages transmitted on that port 

Successful – number of attempts that were successful 

Conn Errors – connection errors that occurred while the port was connected, 
resulting in a failed attempt; some pages may have been transmitted 

Non-conn Errors – errors that occurred prior to achieving connection, resulting 
in a failed attempt; no pages were transmitted 

View Logs 

Logs – any of the following: 

Fax Activity log  - includes a line for both successful and failed fax 
transmit/receive attempts. 

Fax Error log – Records only errors associated with the transmission and receipt 
of faxes.  If there are few errors, this log keeps a longer record of activity since 
it's only including errors. 

General Service log – records the activity of the various server software 
processes, and is typically used for diagnostic purposes.  

Critical Service Errors log – records certain meaningful events that are typically 
errors, though not necessarily errors, and which is generally used for diagnostic 
purposes. 

Alarm log  –  records all activity of the Alarm Management function. 

Translation log – records conversion events, including errors 

Choose A Log by Browsing – other logs which you have saved as text files. 
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View Alarms 

Alarms – a memory-resident version of the Alarm log (Figure 5-14) that gives 
information for the last 5 alarms, according to: 

Number – Alarm ID 

Date/Time – when alarm was generated 

Type --  Alarm event type 

Module – generating alarm 

More Info – a short message describing the alarm event 

 

Figure 5-13.  View Alarm Log Window 

Refer to the Alarm Log itself to see alarm information that is not limited to the last 5 
alarms, and that is not flushed every time the system is rebooted.  Refer to the 
“Clearing an Alarm” section earlier in this chapter for more information on clearing 
an alarm that has been triggered. 

View Installed Options 
Installed Options – a display (Figure 5-14) of the server model and maximum fax 
ports, plus a list of the available server options and whether each is currently 
installed or not, accessible by selecting Installed Options from the View menu. 
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Figure 5-14.  View Installed Options Window
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Chapter Six:  Install and Use Qdoctor 
The Qdoctor (short for Quarantine Doctor) utility enables access to a log of faxes 
“quarantined” on the fax server (and not delivered to the fax gateway for further 
routing).  The faxes were kept on the fax server because they met the specified 
criteria to isolate faxes that may be “Spam” faxes, i.e., junk mail faxes. 

Specified users can then access the log of quarantined faxes and perform the 
following functions: 

• Display detailed information for the received fax in its own 
windowDisplay_Detailed_Information_for_the_Received_Fax_in_its_Own_Window  

• View the received faxView_the_Received_Fax  

• Display the oldest, unread faxDisplay_the_Oldest_Unread_Fax  

• Delete the received faxDelete_the_Received_Fax  

• Release the fax back into the fax 
systemRelease_the_Fax_Back_into_the_Fax_System for another delivery attempt 
to the intended recipient 

• Open another log of quarantined faxes 

• Specify that a Viewed Fax be Marked as 
UnreadSpecify_that_a_Viewed_Fax_be_Marked_as_Unread; if the fax is marked as 
Unread, this function changes to Mark as Read (enabling you to toggle between 
the read/unread states) 

When you install FAXCOM Server software, the drive:\u\Quarantine folder is 
automatically installed and shared, accessible to anyone with access to the 
computer on which FAXCOM Server is installed.  To implement remote client access 
to the Qdoctor utility, make available on your network the setup.exe program 
found in the \drive\u\Quarantine\Client folder.  

Install Qdoctor 
Do the following to install the Qdoctor Utility on your network: 

1. Run the setup program in the \drive\u\Quarantine\Client folder. 

2. When the Welcome screen is displayed, click Next, accept the license agreement 
and click Next to display the Customer Information screen. 

3. Accept the prefilled information or change it as appropriate and click Next to 
display the Setup Type screen. 
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4. Select Complete and click Next to install the utility in the default location 
(C:\Program Files\Biscom\Bin); or select Custom, click Next, click the Change 
button to select another location, click OK and click Next. 

5. When the Ready to Install screen is displayed, click Install to copy the files and 
install the utility.  Click Finish to exit the completed installation. 

Use Qdoctor 
Do the following to use the Qdoctor utility: 

1. Select Start…Programs…FAXCOM…FAXCOM Quarantine Doctor to display the 
Qdoctor main window (Figure 6-1). 

 

Figure 6-1.  Qdoctor Main Window 

2. As appropriate, perform any of the functions explained below. 

Display Detailed Information for the Received Fax in its own 
Window 
You can specify just which columns of information are displayed in the Received log 
of quarantined faxes (by right-clicking anywhere in the log and selecting 
Add/Remove Columns from the shortcut menu).  You can also view all fields of 
information for selected faxes by selecting the faxes, right-clicking, and selecting 
Detail from the shortcut menu.  A window opens displaying the detailed 
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information.  If you selected multiple faxes, the Detail window includes the Next 
button that you can click to display the detailed information for the next selected 
fax.  Figure 6-2 is an example of a Receive Fax Details window. 

 

Figure 6-2.  Receive Fax Details Window 

View the Received Fax 
To view a received fax, either double-click the entry, or select the entry, right-click 
and select View from the shortcut menu.  The fax is opened in the right-hand pane.  
You can then click any of the following toolbar buttons to specify viewing options 
to: 

 
Rotate the page 

Display the pages in thumbnail 

Go to the previous page 

Go to the next page 

Zoom in 

Zoom out 

Fit to window 

Fit to width 
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Fit to height 

Display the Oldest, Unread Fax 
• To display the oldest, unread fax, either click the Get Next Unread Fax button 

, or right-click anywhere in the log and select Get Next Unread Fax from 
the shortcut menu.  You can also select Get Next Unread Fax from the 
Commands menu. 

Delete the Received Fax 

To instantly delete a fax in the log, select the entry and click the Delete button .  
You can also select the entry, right-click and select Delete from the shortcut menu, 
or select the entry and select Delete from the Commands menu. 

Release the Fax back into the Fax System 
To release a quarantined fax back into the fax system, to be delivered to the 

intended recipient, either select the entry and click the Release button , or 
select the entry, right-click and select Release from the shortcut menu.  You can 
also select the entry and select Release from the Commands menu. 

Open another Log of Quarantined Faxes 
Do the following to open another log (folder) of quarantined faxes: 

1. Either click the Open button  to display the Browse for Folder window, or 
select Open from the File menu. 



119 

2. In the Browse for Folder window , locate the 
Quarantine you want to open in the file listing and click OK. 

Specify that a Viewed Fax be Marked as Unread 
There may be situations in which you want to mark a fax you have already viewed as 
being unread – and vice versa.  If so, do the following: 

• Select an entry you have viewed, right-click and select Mark as Unread from the 
shortcut menu. 

• Select an entry you have not viewed, right-click and select Mark as Read from 
the shortcut menu.





121 

Appendix A:  Status Codes and Explanations 
Other than status code 0000, which indicates a successful fax transmission, all 
completion status codes are effectively error messages, as shown in the following 
table: 
Code Status 

Abbreviation 
Explanation 

0000 ok All pages were successfully transmitted. 
0001  hup Lost communication with called fax machine. 
0002  nak Received page quality deemed unacceptable by fax 

machine. 
0003   nois FAXCOM unable to transmit due to noisy phone 

connection. 
0004    voic FAXCOM detected voice answer. 
0005     dis1 Early disconnect.  Remote fax requested a 

disconnect before image was transmitted. 
0006     
  

dis2 Late disconnect; remote fax machine requested a 
disconnect after image was transmitted. 

0007   tone No dial tone detected. 
0008     rset FAXCOM reset during transmission. 
0012     disk FAXCOM device disk error; notify fax service 

administrator. 
0013     busy Called fax machine busy. 
0014     nbsy Phone network busy. 
0015     noan Called phone number ringing but no answer. 
0016    grp1 Incompatible Group I fax machine detected. 
0017     grp2 Incompatible Group II fax machine detected. 
0018      ?mdm Unknown modem.  A modem answer tone was 

detected, but it is not a fax modem. 
0021     noph No destination phone number specified. 
0022      Error reading font during translation. 
0023   Specified form was not detected. 
0030   Incompatible GIII fax receiver detected. 
0031   Transmit Underrun. 
0032   Time out waiting for modem to indicate frame 

sent. 
0033   HDLC timeout (fax port connect error). 
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Code Status 
Abbreviation 

Explanation 

0034   Caller requested unsupported polling mode. 
0035   Cannot dial due to incoming call. 
0036   No font loaded. 
0037   Receiver overrun error. 
0038   Procedural Interrupt received (i.e., paper jam, voice 

mode request). 
0039   Unsupported image type passed to board. 
0041   Bad ISR message. 
0042   Received CED tone too long. 
0050     dead After dialing, no telephone network response. 
0051     rvoi FAXCOM answered call, but no fax at other end. 
0052      rdis FAXCOM receive mode; disconnect requested. 
0070  All pages blank; nothing transmitted. 
0071  Manual dial requested for transmit – not allowed. 
0072  Too many phone numbers specified. 
0073  FAXCOM error, next page not ready in time, abort. 
0074  FAXCOM error, transmit halt. 
0075  FAXCOM error, receive halt – loss of carrier. 
0080  FAXCOM powered down during transmit. 
0081  FAXCOM reset button pressed during transmit. 
0082  FAXCOM reset command received during transmit. 
0083  FAXCOM DTR toggle reset received during 

transmit. 
0084  FAXCOM unknown reset cause. 
0090  FAXCOM async port over-run. 
0091  FAXCOM async port parity error. 
0092  FAXCOM async port framing error. 
0093  FAXCOM buffer overflow. 
0094  FAXCOM internal Queue overflow error. 
0100  nops FAXCOM not configured with PostScript option. 
0101   PostScript option not loaded in this version. 
0102  npcl HP PCL Interpreter did not create any pages. 
0103  nbar Bar Code option is not installed. 
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Code Status 
Abbreviation 

Explanation 

0104   11X17 option not installed. 
0105   Chinese character set option not installed. 
0106  duid Duplicate User ID detected  in job; job is rejected. 
0107 dfid Duplicate File ID detected in job; job is rejected. 
0108
  

tout Job being collected timed-out (no activity detected 
as per FCL time-out setting). 

0109
  

neof Partial job detected; two consecutive $SOF$ 
commands detected; job is rejected. 

0110 nsof Partial job detected; $EOF$ but no $SOF$ 
command at start of job; job is rejected. 

0111 dpho Multiple phone #s detected in job and mode is set 
for single phone number per job. 

0112 bnam Bad file name specified in the $FILESAVE xxxx$ 
command. 

0113  File specified in $GETFILE xxxx$ command does 
not exist. 

0114  bcnt Bad EOF command count. 
0115
  

 Printer configuration error detected; job did not 
print (NPRINT command only). 

0116  Print internal error detected; job did not print. 
0117  next Translation Server option is not installed; cannot 

fax native file attachments. 
0118  part Too many parts (more than 25) in $SETPART$ 

command. 
0119   Internal FAXCOM queue error; resubmit the job. 
0120   No text pass through supported for fax or 

TRANSLATE part without a name. 
0121   Job deleted (Norwest model). 
0122   Bad Mailsend parameter. 
0123  msnd Mailsend option is not installed. 
0124   Mailsend submit error. 
0200  Least Cost Routing option not installed. 
0201  Least Cost Routing option disabled. 
0202  Bad Least Cost Routing address specified, i.e., IP 

address. 
0203  Unable to contact remote site. 
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Code Status 
Abbreviation 

Explanation 

0204  Lost contact with remote site.  
0205  Least Cost Routing agent error preparing job. 
0206  Least Cost Routing agent unable to extract 

destination country code from phone number. 
0601 
- 
0670 

 Internal error; resend the job; if error occurs 
repeatedly, contact Biscom. 

0671  Error converting attachment to fax format. 
0699  Image translation error; no output file created by 

translator; unable to send this fax job. 
0701  Bad set options to the fax device. 
0702  Bad set page header to the fax device. 
0704  Could not open the malloc buffer. 
0705  Could not open the TIFF file. 
0706  Bad get options from the fax device. 
0708  Bad return from DIAL call. 
0709  Bad get call status call. 
0710  Bad send start page call. 
0711  Bad fax device write call. 
0712  Fax failed, due to server crash, ungraceful restart, 

or stopping service when fax was being 
sent/received. 

0715  Bad get page status call. 
0716       Fax board was reset. 
0717  Bad argument parsing in the queue. 
0718  Signal caught, call terminated (hung up). 
0719  Failed to open the fax device. 
0720  Error setting the TX db level. 
0721  Error setting the DIAL db level. 
0722  Error getting the T30 information. 
0723  Fax port is busy receiving. 
0724  Incorrect TIFF file pixel width. 
0725  Fax device is not available. 
0726  Failed to reopen the TIFF file. 
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Code Status 
Abbreviation 

Explanation 

0727  Fax board temporarily out of service; firmware is 
being reloaded. 

0728   Job was canceled. 
0729  Job blocked 
0750 nols Landscape option is not installed. 
0751  $CLOSELINK command detected; the FAXCOM 

proceeded to disconnect the TCP/IP link. 
0752  Initialize 3270 terminal message. 
0770  Dial tone was detected after dialing the number. 
0771   Internal error; resend the job; if error occurs 

repeatedly, contact Biscom. 
0772  Attempt to attach a fax port was unsuccessful 

(possibly due to a configuration error or hardware 
problem. 

0773
  

 Attempt to reset a fax port was unsuccessful 
(possibly due to a configuration error or hardware 
problem. 

0774 
– 
0777 

 Internal error; resend the job; if error occurs 
repeatedly, contact Biscom. 

0778  An error occurred attempting to play a voice 
prompt for DTMF digits. 

0779 
– 
0781 

 Internal error; please resend the job; if these errors 
occur repeatedly, contact Biscom. 

0782    Not an error; confirmation of an abort request 
from a callback function. 

0783   Miscellaneous hangup. 

0784   Inconsistent fax board configuration settings. 
0785   Wait for call timeout. 
0786   Cancel accepted. 
0787   Fax board initialization failed. 
0800
  

 Internal FAXCOM error; please resend job; if these 
errors occur repeatedly, contact Biscom Technical 
Support. 

8000     qdel This job was manually deleted. 
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Code Status 
Abbreviation 

Explanation 

8001 rej This job was rejected. 
9000      Error in queue management. 
9001  Delay setting exceeds the maximum allowed value. 
9002  No data to send. 
9003  Access is denied. 
9004  Error reading the cover page PDL file. 
9005  Error parsing TO: field command string. 
9006  Concurrent sending of Epson and PostScript is not 

permitted. 
9007  No PostScript support.  The NET software detected 

is not a publisher. 
9008  Cannot attach WordPerfect files. 
9009  Cannot attach MSWord files. 
9010  Cannot attach HP PCL files. 
9011  Error reading attachment files. 
9012      Non-compatible attachment. 
9013      Error creating fax message. 
9014       Cannot mix PostScript, PCL, and Epson files. 
9015 inac Entered Account Number was invalid. 
9016 acct Error opening Accounts file. 
9017 env Too many addresses. 
9018 addr No phone number in address field. 
9019  User license limit exceeded. 
9020  Authorization Code ‘c’ not necessary for this 

recipient. 
9021  Authorization Code ‘c’ must be entered for this 

recipient. 
9022 acct No account number to substitute for "c" in phone 

number, or sender is not authorized, or no valid 
code associated with sender. 

9023  Unable to access Authorization Code table. 
9024  Error in RTF memo. 
9025 rstr Recipient Facsimile Number has been restricted. 
9026  Fax could not be routed to this recipient. 
9027 efwd Error forwarding fax. 
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Code Status 
Abbreviation 

Explanation 

9028  Error submitting fax.  User fax Quota has been 
exceeded. 

9080  No authorization code was specified in the dial 
string.  The job was aborted. 

9081  No authorization code was found for this user.  
The job was aborted. 

9100  Cannot mix graphics and PostScript files. 
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Appendix B:  Configure Advanced Settings 
While typically you do not have to configure advanced server parameters, there may 
be some functions you want to implement by working directly within the 
configuration files.  There are three advanced configuration files – one for fax ports, 
one for host ports/sessions, and one for server settings.   

Specify a Custom Retry Schedule for the Same Host/Session 
in addition to using the default retry interval of 120 seconds, you can specify a 
custom retry schedule for all jobs from the same host or session as follows: 

1. On the Host Ports tab (Figure B-1), select the Host Port for which to specify the 
custom schedule, stop the port if running, and click the Configure button to 
display the Host Ports dialog. 

 

Figure B-1.  Host Ports Tab 

2. On the Host Ports dialog, click the Advanced button to display the Env file (Figure 
B-2). 

3. When prompted whether to proceed, click Yes.   
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Figure B-2.  Host/Session Env File 

4. In the Parameter field, add the following entry:  FAX_RETRY_INTERVAL. 

5. In the Value field, add the appropriate values, where the value can either be a 
single integer specifying the number of minutes to delay before retrying, or n@m 
specifying n retry intervals of m minutes each, as, for example:  5, 3@15, 30.  

6. Click the Set button.  Click Close. 

Archive MAILSEND and NPRINT Jobs 
Archiving of MAILSEND and NPRINT jobs is automatically enabled after a fresh install 
of Release 5.5.  If, however, you are upgrading to Release 5.5 from a release earlier 
than 5.4, you must do the following to enable the capability: 

1. Access the Server Settings tab (Figure B-3). 
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Figure B-3.  Server Settings Tab 

2. Click the Advanced button to display the Server Settings Env file (Figure B-4). 

3. When prompted whether to proceed, click Yes. 
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Figure B-4.  Server Settings Env File 

4. Locate the ARC_JOB_TYPE_TX_SMTP parameter and/or the 
ARC_JOB_TYPE_TX_NPRINT parameter and set the value to Yes. 

5. Click the Set button.  Click Close. 

Control the Size of the Fax Activity and Fax Error Log 
You can do the following to control the size (approximate maximum number of 
records) of the Fax Activity log (fax.log) and Fax Error log (faxerr.log): 

1. Access the Server Settings tab and click the Advanced button to display the Env 
file (Figure B-4). 

2. Locate the LOG_ACT_LOG_LEN and LOG_ERR_LOG_LEN parameters and specify the 
appropriate value. 

3. Click the Set button.  Click Close. 
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Specify the Archive Directories Structure 
You can specify whether the archive directory structure includes daily subdirectories 
– rather than the default flat structure – as follows: 

1. Access the Server Settings tab and click the Advanced button to display the Env 
file (Figure B-4). 

2. Locate the ARC_MOVE_DIR_STRUCTURE parameter. 

3. Change the value from One to Multiple. 

4. Click the Set button.  Click Close. 

Add Selectable Date/Time Formats 
By default, date format is tied to country code, with country code 1 using American, 
and all others using European. 

Through the Server Settings Env file, however, you can have more specific control of 
the format, and can specify the following: 

American, European, or International Format – where the general rule is that 
American date format has the month-day-year format, European has day-
month-year, and the global International has year-month-day 

Slash, dash, or dot date delimiter – with slash being the default for American and 
European, and dash being the default for International 

Whether to include or omit time zone expressed numberically – as, for example 
GMT-05:00 for American EST (or simply –0500 when space for longer form is not 
available); if time zone information is requested, the time zone is appended after 
the hh:mm or hh:mm:ss fields 

A date format for faxes and messages sent to users that is separate from the 
date format for administrative interfaces – whereby the date stamps used in 
transmitted/received faxes and banner pages can be different from from the date 
format for log files and administrative interfaces.  For example, if software is 
reading American format dates in log files such as fax.log, then leaving admin 
date format as American my be required.  In that case, however, user date format 
may be set to European or International without affecting the log-reading 
software.  If software is reading American date format in fax stamps (via OCR) or 
banner files, then leaving user date format as American may be required.  As of 
Release 5.5, for implementation simplicity, the format of the date field at the 
beginning of ims_log lines is always International (yyyy-mm-dd). 

Do the following to select date/time formats: 

1. Access the Server Settings tab and click the Advanced button to display the Env 
file (Figure B-4). 
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2. Locate the appropriate parameter and specify the appropriate value, where the 
relevant parameters are: 
FAXCOM_DATE_DELIMITER_AMER 

FAXCOM_DATE_DELIMITER_EURO 

FAXCOM_DATE_DELIMITER_INTL 

FAXCOM_DATE_FORMAT_ADMIN 

FAXCOM_DATE_FORMAT_USER 

FAXCOM_DATE_INCLUDE_TIME_ZONE 

3. Click the Set button.  Click Close. 

Stamp a Fax Header on Other Delivery Types 
Do the following to stamp a fax header on fax-formatted deliveries by means other 
than fax, such as delivery to printer, delivery to file destination,  and delivery to email 
destination: 

1. Access the Server Settings tab and click the Advanced button to display the Env 
file (Figure B-4). 

2. Locate the appropriate parameter (listed immediately below)and change the 
default of No to Yes: 
FAX_HDR_JOB_CAPTURE 
FAX_HDR_MAIL_SEND 
FAX_HDR_NPRINT 
FAX_HDR_PRINTON 

3. Click the Set button.  Click Close.
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Appendix C:  Use the FAXCOM Control Utility 
You can control certain functions of the FAXCOM Server by running the FAXCOM 
Control utility.  To run the utility, type the following at the command line: 

bisctrl 

The following is displayed to guide you in using the utility with the appropriate 
command switches: 
bisctrl [-k fax/host port name] 
    -k stop host/fax port 
           i.e. -k host1 
 
bisctrl [-s fax/host port name] 
    -s start host/fax port 
           i.e. -s host1 
 
bisctrl [-c fax port name] [-m transmit/receive mode] [-r auto routing mode] 
    -c configure fax port 
    -m configure transmit/receive mode [NONE|TX|RX|TXRX] 
    -r configure auto routing mode [DID|DTMF|NONE] 
           i.e. -c fax1 -m TXRX -r DID 
 
bisctrl [-c host port name ] [ -m mode ] [-p tcp port] [-b baud rate] 
    -c configure host port 
    -m configure mode [TCP|TRAN|COM1|COM2] 
    -p configure tcp port number (must be less than 65536) 
    -b configure serial port baud rate 
       [1200|2400|4800|9600|19200|38400|57600|115200] 
           i.e. -c host1 -m TRAN -p 6000 
           i.e. -c host1 -m COM1 -b 19200 
 
bisctrl [-i taskid] 
    -i clear job with specified task id (use with extreme caution) 
 
bisctrl [-j] 
    -j display job and port status 
 
bisctrl -e [-f fax/host port name] ENV_NAME ENV_VALUE ... 
    -e set ENV values for fax/host port or (by default) server 
 
bisctrl [-g|-u] [-f fax/host port name] ENV_NAME ... 
    -g get ENV values 
    -u unset ENV values 
 
bisctrl -n [-f fax/host port name] ENV_NAME ENV_VALUE ... 
    -n create new ENV values 
    (fail if name already exists) 
 
bisctrl [-x] 
    -x clear all fax delivery jobs 

Note:  Make sure that you first determine that no fax job is being processed 
before you issue the bisctrl –k command to kill a host or fax port. 
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Appendix D:  Dialogic Brooktrout Fax Board Device Driver 
Parameter Values 

Overview 
It is possible you may have to specify values other than the defaults for the Dialogic 
Brooktrout Fax Board Device Driver software – in order to implement capabilities you 
require.  While certain parameter values should not be changed unless requested by 
Biscom Support personnel, the 3 listed below are ones you might need to change. 

Change the Values 
To change these values, access the registry, where the values are found under the 
key: 

//HKEY_LOCAL_MACHINE/Software/Biscom/FAPI for BT/Parameters 

CallerIdSubstituteTSI (default 0) 

This value is a switch which turns on (0 = OFF, 1 = ON) the substitution of the 
received "Calling Party Number" for the received TSI on inbound fax calls on ISDN 
(BRI, PRI, or E1) lines. 

CallingPartyNumber (default "") 

This value is used when transmitting on ISDN lines (PRI, BRI, and E1).  It specifies a 
telephone number, typically the number of the fax server, which is transmitted as 
part of the ISDN call establishment protocol. 

PoundsignPostfixDID (default 0) 

Note:  This value is a switch (0 = OFF, 1 = ON) which causes a "#" character to be 
appended to the end of the received DID string. 
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Appendix E:  Supported Fax Boards 
The FAXCOM Server supports Dialogic Brooktrout PCI boards, as follows: 

Analog/DID 

TruFax 200-R CH 2 Analog (PCI) 

TruFax 200E 2CH 2 Analog (PCI EXPRESS) 

TR1034+UP2C-R-1Loop Channel/1 DID Channel 

TR1034+uP2D-R-2 DID Channels 

TR1034+uP4C-R-2 Loop Channel/2 DID Channel 

TR1034+uP4DR-4 DID Channels 

TR1034+P8L-8L 8 Channel Analog Fax 

TR1034+E2L-2L 2 CH Analog Fax Bd (PCI Express) 

TR1034+E4L-4L 4 CH Analog Fax Bd (PCI Express) 

TR1034+E8L-8L 8 CH Analog Fax Bd (PCI Express) 

TR1034+E2C-1 Loop CH/1 DID CH (PCI Express) 

TR1034+E2D-2 DID Channel (PCI Express) 

TR1034+E4C-2 Loop CH/2 DID CH (PCI Express) 

TR1034+E4D-4 DID Channel (PCI Express) 

Digital (T1, BRI, E1, PRI, ISDN) 

TR1034 T1/E1/IP PCI Express (low profile, half length, single slot) 

TR1034+P16H-E1-1N 16Port E1/PRI w/T.38 Connector 

TR1034+P20H-E1-1N 20Port E1/PRI w/T.38 Connector 

TR1034+P30H-E1-1N 30Port E1/PRI w/T.38 Connector 

TR1034 +P4H-E1-1N with T.38 Connector 

TR1034+P2-1B 2 Port Single Line BRI 

TR1034+P4-2B 4 Port Two Line BRI 

TR1034+E2-1B 2 Port Single BRI 

TR1034+E4-2B 4 Port Two Line BRI 

TR1034+E4H-E1-1N with T.38 Connector 

TR1034+E8H-E1-1N 8 Port E1/PRI w/T.38 Connector 

TR1034+E10H-E1-1N 10 Port E1/PRI w/T.38 Connector 
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TR1034+E16H-E1-1N 16 Port E1/PRI w/T.38 Connector 

TR1034+E20H-E1-1N 20 Port E1/PRI w/T.38 Connector 

TR1034+E30H-E1-1N 30 Port E1/PRI w/T.38 Connector 

Notes:  If located outside of the United States, check whether your FAXCOM Server 
is located in a country where Dialogic has obtained certification of the TR1034 
analog fax cards, since additional configuration is required to enable country-
specific fine tuning of the telephone network interface.  Refer to the Dialogic 
documentation for information necessary to configure the correct board timing, 
frequencies and call control.
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Appendix F:  Install Translation Server Applications 
If building your own FAXCOM Server and using the Translation Server function, you 
must install Adobe Acrobat and the MS Office suite according to the instructions in 
this appendix.  In addition, this appendix lists some special considerations for using 
the Translation Server successfully. 

Note:  Instead of installing Adobe Acrobat, it is possible to use the FAXCOM 
Server’s embedded PDF viewer by selecting the Use Xpdf for PDF Rendering 
checkbox on the Translation Server tab (Figure 4-29). 

Install Adobe Acrobat 9 
Do the following to install Acrobat 9: 

1. When the installation autoplays, click the Install Adobe Acrobat 9 button. 

2. Specify the appropriate customer information, including the product Serial 
Number and click Next to display the License Activation screen.  Click Next. 

3. When prompted for the Setup Type, select the Custom radio button and click 
Next to display the Custom Setup screen (Figure F-1). 

 

Figure F-1.  Custom Setup Screen 
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4. Select the options shown in Figure G- 1and click Next. 

5. Click the Install button to begin the installation.  When notified that the 
installation is complete, click the Finish button. 

6. Select Start…Programs…Adobe Acrobat 9.  Select Check for Updates… from the 
Help drop-down menu and download any updates. 

7. Select Improvement Program Options… from the Help drop-down menu and 
make sure that the No, thank you radio button is selected.  Click OK.  

Install/Configure Adobe Acrobat 8.0 Standard 
Do the following to install Adobe Acrobat 8.0 Standard: 

1. When the installation autoplays, click the Install Adobe Acrobat 8.0 Standard 
selection. 

2. Specify the appropriate customer information, including the product Serial 
Number and click Next. 

3. When prompted to cache the install, leave the option enabled and click Next. 

4. When the PDFMaker Installation and Integration Information screen is displayed, 
click Next to continue. 

5. When prompted for the Setup Type, select the Custom radio button and click 
Next to display the Custom Setup screen (Figure F-2). 
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Figure F-2.  Custom Setup Screen 

- Select the options shown in Figure G- 1and click Next. 

6. Click the Next button to begin the installation.  When notified that the 
installation is complete, click the Finish button. 

- Select Start…Programs…Adobe Acrobat 8.0 Standard.  Accept the license and 
activate. 

- When prompted whether you would like to register your Adobe product online 
now, select the Don’t Remind me radio button. 

- Check the Do not show at Startup option. 

- Click the Close button. 

- Select View…Toolbars and uncheck everything or select the Hide toolbars (F8) 
option. 

Install MS Office 2007  
Do the following to install MS Office 2007: 
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1. Insert the Office CD in a CD drive.  When prompted, specify your product key 
and click Continue.  Accept the license agreement and click Continue. 

2. Click the Customize button. 

3. If appropriate, select the File Location tab and change the installation 
destination, perhaps to drive D:. 

4. Select the User Information tab and specify your user information. 

5. Select the Installation Options tab; select the Installation options as shown in 
Figure F-3 below, and click the Install Now button. 

 

Figure F-3.  Installation Options Screen 

Install MS Office XP/2003 Applications  
Do the following to install the MS Office XP/2003 applications: 
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Note:  While there is some variation in the look-and-feel of the Office XP and 
Office 2003 installations, the procedure to follow is effectively the same.  

1. Insert the Office CD in a CD drive.  When prompted, specify your product key 
and click Next.  Specify your user information and click Next.  Accept the license 
agreement and click Next.  

- Select the Custom installation type.  If appropriate, change the installation 
destination, perhaps to drive D:.  Click Next. 

- When prompted for the applications to install, select only Word, Excel, and 
PowerPoint (as shown in Figure F-4 for Office 2003). 

 

Figure F-4.  Custom Setup Screen (Office 2003) 

Note:  If used at your site, you can also select Publisher. 

- For Office 2003, check the Choose advanced customization of applications. 
check box.  For Office XP, check the Choose detailed installation options for 
each application. radio button.  Click Next. 

- Select Run all from My Computer for the selected applications  (Word, Excel, 
PowerPoint [and possibly Publisher if in use at your site]). 

- Set everything else to Not Available. 

- Under Shared Features, set Clip Organizer and Visual Basic for Applications to 
Run all from My Computer. 
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Note:  Be aware that while PowerPoint would work without Clip Organizer being 
installed pre SP2, it will NOT work without Clip Organizer being installed post SP2. 

- Under Office Tools, set Microsoft Office Document Imaging to Run all from My 
Computer. 

- Review your installation choices and click the Install button to install the 
selected applications. 

Considerations for Using the Translation Server 
Be aware of these considerations for successfully using the Translation Server: 
• Make sure that no messages requiring a user response are displayed when an 

application is launched to translate a job.  Because the Translation Server cannot 
respond and clear these messages, the result will be that the Translation Server 
times out and declares the job unsuccessful. 

• Before attempting to translate documents created in a newly-installed 
application, make sure you run the application at least once – so that it can 
properly initialize, etc. 

• Configure the three Normal.dot template files, and the MS Word 2007 
Normal.dotm template file, as Read-only.  The files are in the following 
locations: 
\Program Files\Microsoft Office\Office 

C:\Documents and Settings\Administrator\Application 
Data\Microsoft\Templates 

C:\Documents and Settings\Default User\Application 
Data\Microsoft\Templates 

• Right-click each Normal.dot file (and the Normal.dotm file for MS Word 2007) 
and select Properties from the shortcut menu.  On the General Properties tab, 
check the Read only check box.  Click Apply and click OK. 

• Make sure to exclude the following directory from a real-time virus scan: 
C:\Documents and Settings\Default User\Application 
Data\Microsoft\Office\Recent 

• Convey the following information to users of the Translation Server: 
- MS Word users cannot fax password-protected documents. 
- MS PowerPoint users should save PowerPoint color slides in black and white. 
- Visio users cannot fax Visio drawings that are based on a user-created 
stencil. 
- MS Excel users who want to fax multi-sheet documents must first perform 
the following steps in order for only one print job to be generated for all sheets: 
open the document in Excel; right-click the Sheet tab; choose Select All Sheets; 
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select File…Page Setup; in the Print Quality field, select a resolution to be used 
for all sheets; click OK, and save the document. 
- The Translation Server does not reformat a Word document to have at least 
these minimum margins (Top:  0.20”, Bottom:  0.25”, Left:  0.25”, Right:  0.25”). 
If you want the translation engine to reformat the document, include the 
following statement in the FAXCOM Server’s 
%faxcom_root%u\ims\server\bistran.ini file: 
[Translation] 
WordFormat=0 

- If you have documents with very small margins, it is suggested that you 
select PostScript as the Intermediate Format setting on the Translation Server 
tab (Figure 4-28) rather than the default of PCL. 

Logging Print Job Information Events 
Each time a translation job is requested, a print job is logged as an information 
event for the print server, possibly causing more logging than is acceptable to your 
site.  Do the following to verify whether this information event logging is enabled 
for the print server and disable it if appropriate: 

Note:  A print server setting applies to all printers on the print server.  If, 
therefore, you want to disable this logging for FAXCOM Native Translation Server 
only and not for other printers on the print server, you would have to put FAXCOM 
Native Translation Server on its own print server.     
1. Select Start…Settings…Printers. 

2. Select File…Server Properties to display the Print Server Properties dialog. 

3. Select the Advanced tab (Figure F-5). 



148 

 

Figure F-5.  Print Server Properties Advanced Tab 

Typically, the first three checkboxes are selected.  If so, deselect the third 
checkbox, Log spooler information events (as shown in Figure F-5).
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Appendix G:  Implement the Dialogic Brooktrout SR140 
Virtual Fax Board 
The Dialogic Brooktrout SR140 is a host-based fax-over-IP platform for companies 
that have made the transition to VoIP to integrate a pure IP-based fax solution.  
SR140 is a software-only solution that requires no additional hardware. 

This document explains the steps you perform to implement the SR140 software-
only solution on a FAXCOM Server. 

Note:  When implementing SR140 on a virtual machine, make sure to assign the 
MAC address manually instead of allowing VMware Workstation to assign it 
automatically.  

Steps You Perform on the FAXCOM Server 
1. During the installation of the FAXCOM Server software, you specify use of the 

SR140 software-only solution on the Fax Board Type screen (Figure 1-7 in this 
document and also reproduced below). 

 

Figure G-1.  Fax Board Type Screen 
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You then specify the appropriate T.38 settings on the T.38 Gateway screen, 
shown below. 

 

Figure G-2.  T.38 Gateway Screen 

T.38 Call Control – the call control method used for Voice Over IP, either: 

SIP for the Session Initiation Protocol, a text-based protocol, similar to HTTP 
and SMTP, designed to manage multimedia sessions over the Internet; while SIP 
is responsible for determining the peer IP address and port number on which to 
communicate, it does not perform the actual physical transport of the media, 
which is typically done via TCP/IP. 

H.323 for the standard that describes how multimedia communications occur 
between terminals, network equipment, and services, and which is part of a 
larger group of ITU recommendations for multi-media interoperability called 
H.3x.  H.323 addresses call control and management for both point-to-point 
and multipoint conferences as well as gateway administration of media traffic, 
bandwidth, and user participation  

SIP or H.323 Gateway IP Address – the IP Address of the Cisco router in use  
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2. Once the FAXCOM Server is installed, click the Configure toolbar button  
and select the SR140 Settings tab (Figure 4-11 in this document and reproduced 
below).  You can also select Configure…All Settings…SR140 Settings. 

 

Figure G-3.  SR140 Settings 

3. If you have not already done so, make the appropriate selections according to 
your implementation – following the instructions in the “Configuring SR140 
Settings” section in Chapter Four. 

4. Click the License Manager button to display the Brooktrout License Manager, 
with which to activate your SR140 license.. 

5. Select Utilities…Display node lock to display your Node Lock Type and Node 
Lock, as shown in Figure G-4.  Click OK. 

 

Figure G-3.  Activation Node Lock Window 
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3. Select License…Activate license… to display the License Activation Wizard 
Welcome screen.  Click Next. 

4. When the Activation Method screen is displayed, select the Using the interactive 
web method and click Next. 

5. When the Web Instructions screen (Figure G-5) is displayed, click the Save the 
instructions into a file button and click the Save button to save the text file in 
the appropriate location.  (You can then later print the file in order to have a 
copy of both the instructions and the Node Lock when accessing the Activation 
website.)   

 

Figure G-5.  Web Instructions Screen 

6. Click Next; click Finish to exit the wizard.  Exit the utility. 

Steps You Perform on the Dialogic Website 
Once you have obtained your Node Lock Type and Node Lock, do the following to 
perform the activation and generate your license: 

1. From any system on your network, run a Web browser and access the following 
location:  http://www.dialogic.com/activation. 
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2. When the Login page (Figure G-6) is displayed, enter the License Key from your 
SR140 Certificate and click Submit.    

 

Figure G-6.  Login Page 

3. When the Enter Customer Information page is displayed (Figure G-7), specify all 
required information and click Submit. 

 

Figure G-7.  Enter Customer Information Page 
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4. When the Generate, Re-Host or View Licenses page (Figure G-8) is displayed, 
click the Generate Licenses button. 

 

Figure G-8.  Generate, Re-Host or View Licenses Page 

5. When the Select Items to Activate page (Figure G-9) is displayed, select the 
appropriate Node Lock Type in the Node ID Type field and enter the Node Lock 
in the Node ID field.  Click the Generate License button. 

 

Figure G-9.  Select Items to Generate Page 
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6. When the Confirm your Selection page (Figure G-10) is displayed, click the 
Confirm button. 

 

Figure G-10.  Confirm your Selection Page 

7. When the Deliver License page (Figure G-11) is displayed, click the Save to File 
button to save the license information to a file.   Click the Logout button to 
logout of the activation website. 

 

Figure G-11.  Deliver License Page 
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Step to Perform on the FAXCOM Server 
• Once you have saved the license information to a file, locate the license 

information file in the appropriate directory on the FAXCOM Server: 

Either 

drive:\Program Files\Biscom\FAXCOM Server\Cantata SR140 

Or 

drive:\Program Files (x86)\Biscom\FAXCOM Server\Cantata SR140 

 (where drive is the drive on which you installed the FAXCOM Server software 
and the Program Files directory depends on whether the System Type is a 32 bit 
or 64-bit OS). 
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